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Chapter 1

Welcome to Live

1.1 The ableton Team Says: Thank You

Live is the result of musicians wanting a better way to compose, improvise and perform
music using a computer. A lot of effort has been put into making it easy and fun to use,
yet still capable of helping you create music with unlimited depth and sophistication.
This effort continues, even as you are reading these lines. . . in fact, a new, improved
Live version might already be available for download! Please check on our web site now.

We hope you enjoy using Live and that it enhances your creative process. Should you
have suggestions about how we can improve Live, please let us know.
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Your ableton team.

1.2 How to Use This Manual

The Live manual consists of this introduction and the following two chapters: Chapter
2 is a tour of Live, which we strongly recommend for first-time users; Chapter 3 pro-
vides reference on the Preferences, Effects, Menu, MIDI Implementation and keyboard
shortcuts.

We want this documentation to be as helpful as possible. Should you find anything
unclear or incorrect in this manual, please let us know.

1.3 What’s New in Live 3?

1.3.1 Envelopes

• Clips have envelopes for all warp, mixer and effect parameters (see Animating
Samples with Clip Envelopes)

• Envelope Draw Mode for drawing steps and curves (see Drawing Envelopes)

• Better envelope editing: Envelopes can be freely copied between parameters (see
Editing Breakpoints)

mailto:documentation@ableton.com
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1.3.2 Playing Clips via MIDI / Computer Keys

• Clips can be mapped to keyboard ranges for chromatic playing (see Mapping Clips
to MIDI Note Ranges)

• Clips have a velocity amount setting (see Mapping Clips to MIDI Notes)

• Legato Mode for starting clips without retriggering (see Legato Mode)

• All Launch Modes available for computer keyboard keys (see Launch Modes)

1.3.3 Arrangement and Session View

• Consolidate command turns the Arrangement selection into a new clip (see Consolidate)

• A new command to capture all running clips as a new Session View scene (see
Insert Captured Scene)

• Session View clips keep playing when dragged to other slots

1.3.4 Quantization / Grid

• The Quantization menus include triplets

• The global Quantization setting can have values greater than one bar
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1.3.5 Live Effects

• Compressor II – advanced dynamics (see Compressor II)

• EQ 3 – three band DJ-style EQ with 48 dB band separation (see EQ Three)

• Utility – gain, stereo width and phase control (see Utility)

• Resonators – strings, chords and shimmer (see Resonators)

1.3.6 VST Plug-Ins

• Multiple VST editor windows (see Showing Plug-In Panels in Separate Windows)

• New VST program and bank handling (see VST Programs and Banks)

• OS X: support for Mach-O plug-ins

1.3.7 Recording

• Automatic handling of monitoring (see Monitoring the Audio-Ins)

• Automatic thinning of recorded automation data

1.3.8 Clip Settings

• Clips can be set to play from RAM instead of from disk (see Clip RAM Mode)
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• Dropping a sample from the File Browser onto the Clip View replaces the clip’s
sample (see Using Clips as Templates)

• Greater ranges for clip volume and transposition



Chapter 2

A Tour of Live

2.1 First Steps

When you have installed Live and run it for the first time, you will be presented with
the Welcome dialog.

If you own Live, you can unlock Live using this dialog. For details on unlocking and
copy protection, please see the respective manual section (see Live’s Copy Protection).

If you do not (yet) own Live, please click the “Run Demo” button to proceed. You will
be able to work with all of Live’s features with the exception of saving, rendering to
disk and resampling.
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2.1.1 The Live Screen

Most of your work in Live happens in the main Live screen. This screen consists of a
number of views. Each view manages a specific aspect of your project.

The Live Screen.
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One view is always there: The Control Bar, located at the top of the screen, contains
global controls for tempo, the metronome, synchronization, tape deck-like transport
and system monitoring.

As screen space is limited, the other Live views cannot all be up at the same time–
even if you run Live in Full Screen Mode (see Full Screen), which is toggled by pressing
the F11 key. Rather than cluttering the screen with overlapping windows, Live offers a
number of fast methods to access each view and configure the screen according to your
needs:

A View Selector.

Each one of the selector buttons at the screen borders calls up a specific view; click this
one, for instance, to access the Live effects.

A View Show/Hide Button.

To hide a view, thus freeing up screen space, click on the triangle-shaped button next
to it. To restore the view, click the button again.

Adjusting the Main Window
Split.

You can adjust the main window’s horizontal split by dragging.

This tour will take you through all the views and explain their purposes. Let’s start with
the Info View, which is tremendously helpful when working with Live.
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2.1.2 Getting Help from the Info View

The Info View provides information about the area of the interface currently under the
mouse.

The Info View.

If you can’t remember a particular control or view function, the Info View tells you what
it is and what you can expect it to do. If you need more information, please consult
the manual.

2.1.3 Opening a Live Set from the Browser

Live has a number of built-in Browsers.

A File Browser Selector.

The three File Browsers are used for navigating the file system, pre-listening and loading
samples (see Browsing and Pre-Listening), and for opening Live documents (so-called
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Live Sets).

The Live Effects Selector.

The Live Effects Browser contains all built-in effects (see The Live Effects).

The Plug-In Effects Selector.

The Plug-In Effects Browser gives you access to your VST Plug-ins (see Using VST Plug-
Ins).

To start with, let’s load Live’s demo song. After installation, the topmost Browser should
contain an item called “Live Demo Arrangement.als.” Please double-click this Live Set
to open it.

2.1.4 Arrangement and Session View

Live has two main views which can be toggled by pressing the computer’s tab key or by
clicking their respective selector buttons.

The Arrangement View
Selector.

The Arrangement View displays the Arrangement, which contains music laid out along a
song timeline, like a multitrack tape.
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A Piece of Music Laid out in
the Arrangement View.

Much like you would record onto tape, you can record multiple tracks of audio into the
Arrangement (see Recording Audio). Unlike music stored on tape (or in a traditional
digital audio workstation), you can change your recordings’ tempo at any time. The
Arrangement View is a powerful audio editing tool that easily lets you combine and
arrange audio of all types: loops, sound effects and complete pieces of music.

The Session View Selector.

The Session View is a vertical layout of tracks, much like the channel strips of a mixing
console. In fact, the Session View acts as Live’s mixer (see Mixing and Effects).
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The Session View Acts as
Live’s Mixer.

The Session View also hosts clips for live playing, which you can hide or show by
toggling the View menu’s “Clips” option. Session clips offer many exciting possibilities
for creating and performing music, which we will investigate soon (see Playing Session
Clips).

The Session View Hosts Clips
for Live Playing.

Your Session View playing can be recorded into the Arrangement, allowing for an impro-
visational approach to composing songs and scores.
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2.1.5 Clips and Tracks

Please switch to the Arrangement View and press the computer’s space bar to listen to
the demo song. As you listen to the demo song, you can observe Live traversing an
arrangement of clips along the song timeline.

A Clip in the Arrangement
View.

A clip represents a piece of sound. The clip does not actually contain the sound; instead,
it references a sample file on the computer’s hard disk. When the clip is played, it tells
Live what part of the sample should be played and how:

• as a loop or as a “one-shot”;

• in sync with the current song tempo or un-synced;

• at what pitch;

• . . . and many other options.

The respective settings are made in the Clip View, which appears at the bottom of the
screen when a clip is double-clicked.

The Clip View.
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Many interesting variations of a sample can be created just by changing the clip prop-
erties, without generating bulky new audio data. We will be talking about adjusting the
clip properties (see Setting Clip Properties) and envelopes (see Animating Samples with
Clip Envelopes) later.

Clips reside in tracks, which appear as horizontal rows in the Arrangement View and as
vertical columns in the Session View. (Please note that both views display the same set
of tracks.)

Apart from hosting clips, tracks are important because they contain a mixer stage and
effects to process the audio delivered by the clips. A track’s effects are accessed via
the Track View, which appears at the bottom of the screen when the track’s name is
double-clicked.

Effects in the Track View.

General concepts of mixing and effects are covered by the respective manual section
(see Mixing and Effects); Live’s built-in effects are discussed in the reference section
(see The Live Effects).

To create additional tracks, use the Insert Track command (see Insert Track). To delete
a track, click on its name and choose Delete from the Edit menu. To rename a track,
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click on the track name and select the Edit menu’s Rename command. Tracks can be
re-ordered by dragging their names.

As you will often need to toggle between the Clip View and the Track View, there is a
handy shortcut: Press the Tab key with the Shift modifier held down.

2.2 Navigation and Transport

2.2.1 Arrangement Navigation

Live offers several fast methods for zooming and scrolling the Arrangement display:

3 4 5 61 2

Navigating the Arrangement
View.

1. To smoothly change the zoom level, click and drag vertically in the song time ruler
above the track display (you can also drag horizontally to scroll the display).
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2. To zoom in and out around the current selection, use the computer keyboard’s
+ and - keys. To “pan” the display, click and drag while holding the Alt (PC) /
Option (Mac) modifier.

3. The Arrangement Overview is like a “bird’s-eye view” of your music. It always
shows the complete piece, from start to end. The black rectangular outline repre-
sents the part of the Arrangement that is currently displayed in the Arrangement
display below. To scroll the display, click within the outline and drag left or right;
to zoom out and in, drag up and down.

4. To change the displayed part of the Arrangement, drag the outline’s left and right
edges.

5. To see a specific part of the Arrangement in more detail, click on it in the Overview
and drag downwards to zoom in around that part. Note that you can also drag
horizontally to scroll the display. Using this method, you can zoom and scroll to
focus around any part of the Arrangement with just one mouse motion.

6. To have the Arrangement display follow the song position and “turn the page”
automatically, turn on the Follow switch, or use the Follow command from the
Option menu (see Follow).

2.2.2 Transport

The Play Button.

To start playback, click the Control Bar’s Play button.
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The Stop Button.

Stop playback by clicking the Stop button.

You can also toggle playback on and off by pressing the space bar. To continue playback
from the position where it last stopped, hold Shift while pressing the space bar.

The Arrangement Start
Marker.

You can easily set the playback position by dragging the Arrangement Start marker; this
also works while Live is playing.

The Arrangement Position
Fields.

Or, adjust the song position numerically: The Control Bar’s Arrangement Position fields
show the song position in bars-beats-sixteenths. To change the values:

• Click and drag up or down in any of these fields.

• Click and type a number, then hit the Enter or Return key.

• Click and increment or decrement the value with the up and down arrow keys.

All Live controls with a value display use these standard methods for entering values.
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In addition, compound value boxes (e.g., song position fields) allow using the left and
right arrow keys or “.” and “,” to jump between the fields.

2.2.3 The Arrangement Loop

The Loop Switch.

For Live to repeatedly play a section of the Arrangement, activate the Arrangement Loop
by clicking on the Control Bar’s Loop switch.

The Loop Controls.

You can set the Loop/Region markers numerically using the Control Bar fields: The left-
hand set of fields determines the loop start position, while the right set of fields is the
length of the loop.

The Arrangement’s
Loop/Region Markers.

Alternatively, you can drag the Arrangement’s Loop/Region markers: Dragging the left
and right ends sets the loop start and end points; dragging between the ends moves
the loop without changing its length.

2.2.4 Setting the Tempo

Unlike music stored on tape or in a traditional digital audio workstation, the music
in Live remains “elastic” at all times. Live is capable of time-warping samples while
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streaming them from disk so as to synchronize them to the current project tempo. This
happens without affecting the pitch, which can be changed independently. Mixing and
matching audio from different origins is therefore extremely easy.

The Control Bar’s Tempo
Field.

The Control Bar’s Tempo field allows you to change the playback tempo of your Live Set
at any time, in real-time. You can even automate the tempo (see Editing the Tempo
Automation) to create smooth or sudden tempo changes along the song timeline.

You can have an external sequencer (or drum machine) play along with Live or have Live
play along with the sequencer. The respective settings are made in the MIDI Preferences
(see MIDI Preferences), and the EXT switch next to the tempo control is activated to
have Live follow an external MIDI clock source.

2.2.5 Tapping the Tempo

The Tap Button.

You can use Live’s Tap Tempo function to set the tempo at any time. As you click the
Control Bar’s Tap Tempo button once every beat, the audio in the Live Set will follow
your tapping.

The Key Map Mode Switch.

It’s better to assign the Tap button to a computer key than using the mouse. Click
on the Control Bar’s KEY switch to enter Key Map Mode; then select the Tap button;
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press the key you would like to use for tapping; click the KEY switch again to leave Key
Map Mode. The assignment will take effect immediately. The Tap button can also be
assigned to a MIDI note or controller, like a foot switch, in a similar fashion (see MIDI
Implementation).

Although Live responds to your tapping immediately, it does apply some degree of
inertia to prevent sluggish behavior in the software. The more taps Live receives in a
row, the more precisely it will be able to conclude the desired tempo.

You can also use tapping to count in: If you are working in a 4:4 signature, it takes
four taps to start song playback at the tapped tempo.

2.3 Browsing and Pre-Listening

A sample is a standard WAV or AIF sound file. On the Macintosh, Live is capable of
reading samples in Sound Designer II format as well. Live can combine mono or stereo
samples of any length, sample rate or bit depth without prior conversion. As Live plays
the samples directly from disk, you can work with a large number of (large) samples
without running into RAM memory limitations.

2.3.1 Browsing Samples

Samples are searched and imported from disk using Live’s on-board Browsers, which can
be pointed to any folder location on the computer:
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The File Browser’s Folder-Up
Button.

The Folder-Up button moves up one step in the disk hierarchy. Clicking this enough
times will take you to your computer’s desktop. Now you can browse through the disk’s
folders.

The File Browser’s Root
Button.

After locating the folder with the samples you want to use, you may optionally make
this folder the Browser root by clicking the Root button. Note that there are three File
Browsers which you can set up to point to commonly used folders.

2.3.2 Pre-Listening Samples

The Pre-Listen Switch.

Activate the Browser’s Pre-Listening switch.
Selecting a Sample to
Pre-Listen.

Click on the samples (or use the arrow up and down keys) to select and listen to them.

If your audio hardware offers multiple audio outs, you can privately audition samples
via headphones connected to a separate pair of outs– while the music continues to play.
The output bus for pre-listening is set using the Audio Preferences’ Pre-Listen menu (see
Pre-Listen).

If you like a sample, drag it into the open Live Set.
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2.4 Editing Arrangements

In Live’s Arrangement View, music is represented by clips, waveforms and envelopes. We
will now look at Live’s powerful methods for editing musical material in the Arrangement
View.

2.4.1 Non-Destructive Editing

You cannot destroy anything using these methods: Thanks to Live’s unlimited Undo
history (see Undo) you can always return to the previous state of your Live Set. Fur-
thermore, none of your editing in Live alters the audio samples stored on your hard
drive. A clip simply references (points to) external audio samples.

2.4.2 Arranging Clips

A piece of audio is represented by a clip (see Clips and Tracks) sitting at some song
position in one of Live’s tracks.

Moving a Clip.

Dragging a clip moves it to another song position or track.
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Changing a Clip’s Length.

Dragging a clip’s left or right edge changes the clip’s length.

Clicking a clip selects the clip for editing using one of the Edit menu’s commands (see
The Edit Menu). Note that learning the Edit menu’s keyboard shortcuts can save you a
lot of mouse motion.

The Edit menu commands can apply to more than one clip at a time: Extend the selection
by shift-clicking on another clip in the same track or another, or in the Arrangement
display’s background.

To play what is currently selected, or to play from the flashing insert mark, press Option
- space bar on a Mac / Control - space bar on a PC.

2.4.3 Using the Editing Grid

The Snap to Grid Switch.

If the Snap to Grid switch is on, the cursor will snap to grid lines that represent the
meter subdivisions of the song tempo. This grid adapts to the zoom level.

The Quantization Chooser.

If Snap to Grid is off, the cursor will snap to the fixed quantization grid selected from
the Control Bar’s Quantization chooser. To work without snapping, choose “None.”
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You can also change the quantization grid from the Options menu or with keyboard
shortcuts. To quickly toggle grid and quantization snapping, use the Control (PC) /
Command (Mac)-G hotkey.

2.4.4 Editing Audio Waveforms

To display the audio played by a clip, “unfold” its track by clicking the triangular button
next to the track name.

Adjusting an Unfolded
Track’s Height.

Notice that you can adjust the height of the unfolded track by dragging the split line
below the unfold button.

Now you can drag to select a portion of the audio waveform and choose one of the Edit
menu’s commands (see The Edit Menu) to perform a particular editing operation.

The Result of Splitting a
Clip.

By choosing the Split command (see Split), for instance, you can divide a clip into
smaller parts.
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The Edit menu’s Consolidate command (see Consolidate) consolidates all the clips in the
selection into one new clip per track. This is very useful, for instance, for creating new
loops.

There is a handy shortcut for selecting time within a clip that does not require unfolding
the track: Click on a clip box with both Alt (PC) / Option (Mac) and Control (PC) /
Command (Mac) held down.

2.5 Mixing and Effects

2.5.1 The Live Mixer

Live includes a mixer section which is accessible from two views:

The Arrangement View Mixer.

In the Arrangement View, the mixer appears as a horizontal strip to the right of the
track area. To display all mixer controls for a track, unfold the track and adjust its
height accordingly.
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The Session View Mixer.

The Session View is a standard vertical mixer layout. Uncheck “Clips” from the View
menu to hide the clips from the Session View mixer, thus creating a more spacious mixer
layout that fits more tracks on screen.

You’ll likely find the Session View mixer more intuitive than the Arrangement mixer,
which is nonetheless useful as it displays everything in one place. This comes in handy
when you work with automation (see Recording Automation). Note that the View menu
allows you to show and hide the mixer, while the Tab key toggles between the Arrange-
ment and Session Views.

Let’s look at the mixer controls:
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The Mixer Controls.

1. The Meter shows the track’s RMS (average) and peak output level. However, it
shows the input level while monitoring.

2. The Volume control adjusts the track’s output level.

3. The Pan control positions the track’s output in the stereo field. To reset the pan
control to center, click on the little triangle.

4. To mute the track’s output, turn off the Track Activator switch.

5. The Solo switch solos the track by muting all other tracks, but can also be used
for pre-fade listening (see PFL Switches).

6. If the Monitoring switch is on, you monitor (see Monitoring the Audio-Ins) the
track’s input signal.

7. If the Arm Recording switch is on, the track is record-enabled (see Recording
Audio).
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2.5.2 Using the Live Effects

Effects in the Track View.

Every track in Live can host an unlimited number of Live Effects. The Track View is
where you insert, view and adjust the effects for the selected track. To select a track
and open the Track View to access its effects, double-click the track’s name. The Track
View appears in the bottom area of the Live screen.

The Live Effects Browser
Selector.

Now, click on the Live Effects selector in the Browser area to access the palette of Live’s
built-in effects. To place one instance of the effect in the track, pick the desired effect
and drag it into the Track View. Play with the effect’s controls to change the sound. To
learn what an effect does and how to operate it, consult the Effect Reference section
(see The Live Effects).

To add another effect to the track, simply drag it there or double-click its name to
append it to the end of the effect chain. Audio travels from left to right on the track,
and you can drop effects in at any point.

To remove an effect from the chain, click on the name and either press your computer’s
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Delete or Backspace key, or select Delete from the Edit menu. To change the order of
effects, drag an effect by its name and drop it between any of the other effects in the
Track View, or drag it onto another track in the mixer to place the effect in that track.
Generally, effects can be placed, re-ordered and deleted without interrupting the audio
stream.

The Effect Activor Switch.

Effects can be turned on and off using their Activator switches. Turning an effect off
is like temporarily deleting it: Audio remains unprocessed, and the effect does not
consume CPU cycles. Live effects generally do not load down the CPU unless they are
active. For more information, please refer to the CPU load section (see Managing the
CPU Load).

2.5.3 Live Effects Presets

Every Live effect can store and retrieve particular sets of parameter values as Presets.
Two buttons for managing the effect presets are located on the top right of each effect.

The Recall Preset Button.

To audition presets for possible selection, click once on the Recall Preset button to make
the preset chooser appear. Use the arrow up and down keys to go through the existing
presets while listening to how they sound and watching the effect settings change. To
select a preset by name, click on the chooser to open it. The available presets will be
listed and sorted alphabetically:
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• Factory Settings is the effect’s default state when it is inserted from the effects
Browser. This preset is always at the top of the list.

• Below the factory settings are the Factory Presets, which are installed with the
program. These presets are updated as new versions of Live become available.

• The User Presets are listed below the factory presets. You can create any number
of user presets that are not bound to a particular instance of the effect or to the
current Live Set. They will be available in any other instance of the effect and
any other Live Set as well.

The Preset Save Button.

The Preset Save button is for saving, overwriting and deleting user presets. Clicking on
this button opens a dialog window.

The Preset Save/Delete
Dialog.

To overwrite an existing user preset, select it from the list of user presets and click the
Overwrite button.

To save a user preset, type a preset name into the text edit field and click the Save
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button. If a preset with that name already exists, you will be asked if you want to
overwrite that preset. If not, choose a different name and try again. Otherwise, click
on “ok” to overwrite.

To delete a user preset, select it and click the Delete button.

To leave the preset dialog, choose Close.

Each preset is stored as a normal, stand-alone file in the “UserPresets” folder beneath
the Live Preferences folder. This makes it easy to back up or copy presets to another
computer. The UserPresets are located in:

• Mac OS 9 System Folder:Application Support:Ableton:Live

• Mac OS X [Home]/Library/Application Support/Ableton/Live

• Windows [YourProgramsFolder]/Ableton/Live

2.5.4 Send Tracks and the Master Track

So far, we have worked with tracks that play clips. Live also has send tracks and a Master
track; these cannot play clips, but allow for more flexible signal processing and routing.

The send tracks and the Master track occupy the right-hand side of the Session mixer
view and the bottom end of the Arrangement View. Note that you can hide and show
the send tracks using the Sends command in the View menu (see The View Menu).

Like the “normal” clip tracks, the sends and the Master can host any number of effects.
However, whereas a clip track’s effect processes only the audio within that track, send
tracks can process audio sent to them from numerous tracks.
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For example, suppose you want to create rhythmic echoes with a delay effect. If you
drag the effect into a clip track, only clips playing in this track will be echoed. Placing
this effect in a send track lets it receive audio from any number of tracks and add echoes
to them.

The Send Controls.

A clip track’s send control regulates how much of the clip track’s output feeds the
associated send track’s input. What’s more, even the send track’s own output can be
routed to its input, allowing you to create feedback. Please use this feature with care,
as runaway feedback can boost the level dramatically and unexpectedly.

The Master track is the default destination for the signals from all other tracks. Drag
effects here to process the mixed signal before it goes to the master output. Effects
in the Master track usually provide mastering-related functions, such as compression
and/or EQ.

You can create multiple send tracks using the Insert Send Track menu command (see
Insert Send Track), but by definition, there is only one Master track.
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2.5.5 MIDI-mapping Mixer and Effect Controls

You can get more “hands-on” with your project by assigning a MIDI control box’s knobs
and switches to Live’s mixer and effect controls, which often provides a more satisfying
experience compared to using a mouse.

The MIDI Map Mode Switch.

Click on the Control Bar’s MIDI switch, or use the Option menu’s Edit MIDI Map command
(see Edit MIDI Map), to enter MIDI Map Mode. In this mode, you can click on any mixer
or effect control, then assign it to a controller simply by sending the desired MIDI
message (for example, by turning a knob on your MIDI control box). Your assignments
take effect immediately after leaving MIDI Map Mode.

The Key Map Mode Switch.

Switches, buttons and radio buttons can be mapped to the computer keyboard keys as
well. To make an assignment, click on the Control Bar’s KEY switch or use the Option
menu’s Edit Key Map command.

For details about Live’s MIDI implementation, please refer to the MIDI mapping section
(see MIDI Implementation).

2.5.6 Recording Automation

Often, when working with Live’s mixer and effects, you will want the controls’ move-
ments to become part of the music. The movement of a control across the song timeline



2.5. MIXING AND EFFECTS 34

is called automation; a control whose value changes in the course of this timeline is
automated. Practically all mixer and effect controls in Live can be automated, including
the song tempo.

Creating automation is straightforward: All changes of a control that occur while the
Control Bar’s Record switch is on become automation. Try recording automation for a
control, for instance a mixer volume slider. After recording, play back what you have
just recorded to see and hear the effect of the control movement. You will notice a
little red “LED” has appeared in the slider thumb to indicate that the control is now
automated. Try recording automation for track panning and the Track Activator switch
as well; their automation LEDs appear in the upper left corner.

Volume, Pan and the Track
Activator Switch Have Been
Automated.

To delete automation data, simply select an automated control (by clicking on it) and
choose the Edit menu’s Delete Automation (see Delete Automation) command. The
automation LED disappears, and the control’s value stays constant across the entire
song.

You can, of course, re-record a control movement over and over again until it is right.
It might be easier, however, to graphically edit the automation as a breakpoint envelope
in Live’s Arrangement View (see Automation Envelopes in the Arrangement).
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2.5.7 Overriding Automation

In practice, you will often want to try out new control moves without overwriting
existing automation data. Well, nothing is forever in the world of infinite Undo (see
Undo), but it’s easy to disable a control’s automation temporarily to avoid overwriting
existing data: If you change an automated control’s value while not in Record Mode,
the automation LED goes off to indicate the control’s automation is inactive. Any
automation is therefore overridden by the current manual setting.

The Back to Arrangement
Button.

When one or more of the automated controls in your Live Set are not active, the Control
Bar’s Back to Arrangement button lights up. This button serves two purposes:

1. It reminds you that the current state of the controls differs from the state cap-
tured in the Arrangement.

2. You can click on it to reactivate all automation and thereby return to the automa-
tion state as it is written “on tape.”

2.6 Using VST Plug-Ins

Working with VST Plug-ins is very much like working with Live Effects.

Before Live can access any VST Plug-ins, it needs to be told about the location of the
VST Plug-in folder containing the effects you want to use. To do that, go to the Misc
Preferences via the Options menu (or the Live menu in OSX). Under the Misc tab you
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will find the VST Plug-in Folder entry. Click the Browse button to open a folder-search
dialog and locate, then select, the appropriate folder. The VST Plug-ins Browser will
then display all plug-ins it finds in the VST Plug-in folder as well as any subfolders.

A VST Plug-In in the Track
View.

In the Track View, the original VST Plug-in panel graphics will be replaced with a Live
panel; all VST Plug-in parameters are represented in the Live panel and work in the
same way. You can, for instance, map an arbitrary MIDI-controller message to every VST
Plug-in parameter (see MIDI Implementation).

The Plug-In Unfold Button.

You can view or hide the VST Plug-in’s parameters by toggling the triangle-shaped
button in the plug-in’s title bar. To assign any two plug-in parameters to the Live panel
X-Y window, use the drop-down menus directly beneath it.

2.6.1 Showing Plug-In Panels in Separate Windows

The Plug-In Edit Button.
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The Plug-In Edit button opens a floating window that shows the original VST Plug-in
panel. Changing parameters on the floating window has the same effect as changing
them in the Live panel, and vice versa.

By holding down the Control (PC) / Command (Mac) modifier while clicking the Plug-In
Edit button, you can open another window for the plug-in’s original panel. This way, you
can simultaneously view and edit as many plug-ins as desired. The Show/Hide Plug-In
Windows command (see Show / Hide Plug-In Windows) is useful for hiding and showing
all open plug-in windows at once.

Macintosh only: The floating plug-in editor windows do not receive computer key
strokes. If it is necessary to type into the plug-in window, for instance for entering
a serial number or unlock code, hold down Shift while clicking the Plug-In Edit button.
The editor window will then appear as a ‘normal’ application window, rather than as a
floating window, and receive your typing.

2.6.2 VST Programs and Banks

Every VST Plug-in instance “owns” a bank of programs. A program is meant to contain
one complete set of values for the plug-in’s controls. (For some plug-ins, however, a
program contains only a partial description of the plug-in’s state.)

The VST Plug-In Program
Chooser.

To select a program from the plug-in’s bank, use the chooser below the title bar. The
number of programs per bank is fixed. You are always working “in” the currently selected
program, that is, all changes to the plug-in’s controls become part of the selected
program.
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Please don’t mistake the VST Plug-In Program chooser for the Live effects’ preset chooser
(see Live Effects Presets). Whereas the presets for a Live effect are shared among all
instances and Live Sets, the VST programs “belong” to this specific instance of the VST
Plug-in.

Renaming a VST Plug-In
Program.

To rename the current program, select the VST program chooser and execute the Edit
menu’s Rename command. Then type in a new program name and confirm by pressing
Return.

The VST Program/Bank Load
Button.

VST programs and banks can be imported from files. Clicking the VST Program Load
button brings up a standard file-open dialog for locating the desired file.

Windows only: Please select from the File Type menu whether you want to locate VST
Effect Program files or VST Effect Bank files.

The VST Program/Bank Save
Button.

To save the currently selected program as a file, click the VST Program/Bank Save button
to bring up a standard file-save dialog; select “VST Effect Program” from the Format
menu (Macintosh) / from the File Type menu (Windows); select a folder and name. For
saving the entire bank as a file, proceed likewise but choose “VST Effect Bank” as a file
type/format.



2.7. WORKING WITH ENVELOPES 39

2.7 Working with Envelopes

2.7.1 Automation Envelopes in the Arrangement

Most all of Live’s controls can be automated (see Recording Automation). In the Ar-
rangement View, automation curves can be viewed and edited as breakpoint envelopes.

1 23 4 5

An Automation Envelope in
the Arrangement View.

1. To access a track’s envelope, “unfold” the track by clicking the triangular button
next to the track name.

2. Clicking on one of the track’s mixer or effect controls will display this control’s
envelope.

3. The envelope appears “on top of” the audio waveform. In the envelope display,
the vertical axis represents the control value and the horizontal axis represents
time. For switches and radio buttons, the value axis is discontinuous.
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4. The Automation Device chooser either selects the track mixer, one of the track’s
effects or “None” to hide the envelope. It also provides you with an overview of
what devices actually have automation by displaying their labels in red.

5. The Automation Control chooser selects a control from the device chosen in the
Automation Device chooser. The labels of automated controls appear red.

2.7.2 Drawing Envelopes

With Draw Mode enabled, you can click and drag to “draw” an envelope curve.
The Envelope Draw Mode
Switch.

To toggle Envelope Draw Mode, select “Envelope Draw Mode” from the Options menu,
click on the Control Bar’s Draw Mode switch, or press Control (PC) / Command (Mac)-B.

Drawing an Envelope.

If Snap to Grid (see Using the Editing Grid) is on, drawing creates steps as wide as the
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visible grid (which adapts to the zoom level); if Snap to Grid is off, drawing creates steps
as wide as the fixed quantization setting selected from the Control Bar’s Quantization
chooser. For freehand drawing, choose “None” from the Global Quantization chooser.

2.7.3 Editing Breakpoints

With Draw Mode off, the envelope display looks and works differently. The line segments
and the breakpoints connecting them become draggable objects. Clicking and dragging
in the envelope’s background defines a selection. Here is what you can do:

• Double-click at a position on a line segment to create a new breakpoint there.

• Double-click on a breakpoint to delete it.

• Click and drag a breakpoint to move it to the desired location. If the breakpoint
you are dragging is in the current selection, all other breakpoints in the selection
will follow the movement.

To Move all Breakpoints
Within the Selection, Drag
Any One of Them.

Your movement is constrained by the neighboring breakpoints unless you hold
down the Shift modifier while dragging, which will eliminate breakpoints as you
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wipe over them. Holding down the Control (PC) / Command (Mac) modifier while
dragging switches to a finer resolution.

• Click and drag a line segment between two breakpoints to move it vertically,
without affecting the breakpoint’s horizontal position. If the line segment is in
the current selection, the envelope is moved vertically across the selected time
span. Live inserts breakpoints at the selection’s edges to make sure the move
only affects the selected part of the envelope.

Dragging an Envelope Line
Segment Moves the Segment
Vertically.

When moving clips, Live normally moves all automation with the clip. Sometimes, you
might want to lock the envelopes to the song position rather than to the clips, and the
Arrangement View’s Lock Envelopes Switch does just that.

The Lock Envelopes Switch.

There are a number of useful Edit menu commands for editing envelopes (see The Edit
Menu). Note that Live allows you to copy and paste envelope movements not only
from one point in time to another, but also from one parameter to another. However,
there is obviously no meaningful conversion from a pan movement to, say, an equalizer
frequency, and all Live can do is somehow preserve the gesture.
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2.7.4 Editing the Tempo Automation

The ability to dynamically stretch and compress audio to track any tempo or tempo
variation is one of Live’s specialties. In Live, the song tempo is just another automated
control.

To edit the song tempo envelope, unfold the Master track (see Send Tracks and the
Master Track), choose “Mixer” from the top envelope chooser and “Song Tempo” from
the bottom one.

The Tempo Envelope.

When adjusting the tempo envelope, you might want to scale the value axis display,
which is the function of the two value boxes below the envelope choosers: The left box
sets the minimum, and the right box sets the maximum tempo displayed, in BPM.

Note that these two controls also determine the value range of a MIDI controller as-
signed to the tempo.

2.8 Playing Session Clips

In the Arrangement View, as in all traditional sequencing programs, everything happens
along a fixed song timeline. For a number of applications, this is a limiting paradigm:
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• When playing live, or when DJing, the order of pieces, the length of each piece
and the order of parts within each piece is generally not known in advance.

• In the theatre, sound has to react to what happens on stage.

• When working along with a piece of music or a film score, it can be more efficient
and inspirational to start with an improvisation, which is later refined into the
final product.

This is exactly what Live’s unique Session View is for.

In the topmost Browser, double-click on “Live Demo Session.als”. The Session View
appears.

A Playing Clip in the Session
View.

Each clip has a triangular button at the left edge. Click the button with the mouse
to “launch” clip playback at any time, or pre-select a clip by clicking on its name and
launch it using the computer’s Return or Enter key. You can then move on to the
neighboring clips using the arrow keys.

Clips can be played at any time and in any order. The layout of clips does not prede-
termine their temporal succession; the Session grid offers random access to the clips it
contains.

Each track (column) can play only one clip at a time. It therefore makes sense to put a
set of clips that are supposed to be played alternatively in the same columns: parts of
a song, variations of a drum loop, etc.

A Session View Scene.
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The horizontal rows are called scenes. The Scene Launch buttons are located on the
rightmost column, which represents the Master track (see Send Tracks and the Master
Track). To launch every clip in a row simultaneously, click on its associated Scene
Launch button. This can be very useful in organizing the live performance of a song
with multiple parts.

Slots With and Without Clip
Stop Buttons.

Click on a Clip Stop button to stop a running clip, either in one of the track’s slots, or
in the Track Status field below the Session grid. Note that you can add and remove the
slot buttons using the respective Edit menu commands (see Add / Remove Slot Button).
This is useful for pre-configuring the scene launch behavior: If, for instance, you don’t
want scene 3 to affect track 4, remove the scene 3 / track 4 slot button.

Clips can be moved around the Session Grid by drag-and-drop. To move several clips at
once, select them by using the Shift- or Control (PC) / Command (Mac)-modifier before
dragging. You can also click into an empty slot and “rubberband”-select from there.
Scenes can be reordered by drag-and-drop as well. There are a number of Edit menu
commands (see The Edit Menu) that operate on the selected clips.
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Dropping Multiple Clips Into
the Session View.

Of course, you can also drag in new clips from the Browser (see Browsing and Pre-
Listening). If you are dragging multiple clips into the Session View, Live defaults to
arrange them vertically, in one track. Hold down Control (PC) / Command (Mac) prior to
dropping them so as to lay the clips out in one scene.

2.8.1 The Track Status Fields

You can tell a track’s status by looking at the Track Status field just above the active
track’s mixer controls:

A Track Playing a Looping
Session Clip. . .

The pie-chart icon represents a looping Session clip (see Sample Loop / Region). The
number to the left of the circle is the loop length in beats, and the number at the right
represents how many times the loop has been played since its launch.
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. . . A One-shot Session
Clip. . .

The progress-bar icon represents a one-shot (non-looping) Session clip. The value dis-
plays the remaining play time in minutes:seconds.

. . . Monitoring the Input. . .

A microphone icon appears when the track’s Monitoring switch is on.
. . . Playing the
Arrangement.

If the track is playing clips from the Arrangement, a miniature display representing the
Arrangement clips being played appears.

The last option might puzzle you; let’s have a closer look at how Session and Arrange-
ment relate.

2.8.2 Recording Sessions into the Arrangement

The Control Bar’s Record
Button.

When the Record button is on, Live logs all of your actions into the Arrangement:

• the clips launched;

• changes of those clips’ properties (see Setting Clip Properties);
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• changes of the mixer and the effects’ controls, also known as automation (see
Recording Automation).

To finish recording, press the Record button again, or stop playback.

The Arrangement Selector.

To view the results of your recording, bring up the Arrangement View. As you can see,
Live has copied the clips you launched during recording into the Arrangement, in the
appropriate tracks and the correct song positions. Notice that your recording has not
created new audio data, only clips. As clips merely reference the samples on disk, you
don’t have to worry about disk space when recording Session clips.

The Session clips and the Arrangement clips in one track are mutually exclusive: Only
one can play at a time. When a Session clip is launched, Live stops playing back
the Arrangement in favor of the Session clip. Clicking a Clip Stop button causes the
Arrangement playback to stop, which produces silence.

The Back to Arrangement
Button.

Arrangement playback does not resume until you explicitly tell Live to resume by clicking
the “Back to Arrangement” button, which lights up to remind you that what you hear
differs from the Arrangement.

The Stop All Clips Button.

To disable all Arrangement clips simultaneously, click on the Stop All Clips button in the
Master Track Status field.



2.8. PLAYING SESSION CLIPS 49

The clips in the Arrangement and in the Session View exist independently from one
another, which makes it easy to improvise into the Arrangement over and over again
until it’s right.

Furthermore, you can move clips not only within the Session grid, but also from the
Session View to the Arrangement and vice versa by using Copy and Paste, or by dragging

clips over the or selectors.

When pasting material from the Arrangement into the Session View, Live attempts to
preserve the temporal structure of the clips by laying them out in a matching top-to-
bottom order. Moving through the scenes from the top down, you can reconstruct the
original arrangement. This is useful for taking a composed piece of music back to the
improvisational stage.

2.8.3 Mapping Clips to Computer Keys

The keys of the computer keyboard can be used to trigger clips and scenes.

The Key Map Mode Switch.

Click on the Control Bar’s KEY switch or use the Option menu’s Edit Key Map command
(see Edit Key Map) to enter Key Map Mode. In this mode, you can click on any Session
View slot or scene, then assign it to a key simply by typing the key. Key-mapping is also
available for all the other Live controls that have a colored overlay in Key Map Mode.
Your assignments take effect immediately after leaving Key Map Mode.
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2.8.4 Mapping Clips to MIDI Notes

Slots and scenes can be mapped to MIDI messages in MIDI Map Mode, which works much
the same as Key Map Mode. MIDI Map Mode is entered by clicking the Control Bar’s MIDI
Map Mode switch or using the Option menu’s Edit MIDI Map command (see Edit MIDI
Map).

Assigning a slot to a MIDI key is as simple as selecting it and pressing the desired MIDI
key. Velocity Amount Determines

the Influence of Incoming
Notes’ Velocity on Clip
Volume.

The Clip View’s Velocity Amount control allows you to adjust the effect of MIDI note
velocity on the clip’s volume. If it is set to zero there is no influence, and at 100
percent the softest notes play the clip silently.

2.8.5 Mapping Clips to MIDI Note Ranges

You can also assign a slot to a range of keys for chromatic playing:

1. Enter MIDI Map Mode (see Edit MIDI Map).

2. Select the clip or slot to assign.

3. First, play the root key (this is the key that will play the clip at the default
transposition).
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4. While holding down the root key, press keys below or above the root to define the
limits of the range.

Playing a sample across a keyboard range is standard sampler functionality, which, in
conjunction with beat-synchronized playback and real-time quantization, offers new and
exciting creative possibilities. You could, for instance, improvise a new melody onto a
phrase of spoken or sung text, or create variations from a recorded instrumental solo on
the fly.

To take full advantage of this feature, we recommend you explore these related features:

• Legato Mode (see Legato Mode), which we will talk about shortly, adds more
creative freedom to this procedure.

• Clip envelopes (see Animating Samples with Clip Envelopes), in this context,
become beat-synchronized synthesizer envelopes.

• Your results can be captured into the Arrangement (see Recording Sessions into
the Arrangement).

• The Consolidate command (see Consolidate) allows you to compact the recorded
result into a new sample, which you can drag into the Session View for further
playing.

• As the MIDI mappings are bound to the slots rather than the clips, they persist
when the clips are exchanged. This allows you to set up a template Live Set (see
Save Template) with pre-allocated key ranges ready for experimentation.
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2.8.6 Relative Session View Navigation

The Relative Session
Mapping Strip.

Notice that you can make not only absolute mappings to individual slots and scenes, but
also relative mappings to move the highlighted scene and operate on the highlighted
clips:

The Scene Up/Down
Buttons.

Assign these buttons to keys, notes or controllers to move the highlighted scene up and
down.

The Scene Select Field.

Assign this scene number value box to a MIDI controller, preferably with an endless
knob, to scroll through the scenes. For details, see the discussion of Incremental Map
Modes (see Mapping to Incremental MIDI Controllers).

The Scene Launch Button.

Assign this button to launch the highlighted scene.

A Track Launch Button.

Assign these buttons to launch the clip at the highlighted scene, in the respective track.

Relative session mapping is useful for navigating a large Live Set, as Live always keeps
the highlighted scene at the Session View’s center.
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For details on Live’s MIDI implementation, please see the respective section (see MIDI
Implementation).

2.8.7 Real-Time Quantization

Double-click on a clip to edit its properties in the Clip View. The leftmost Clip View
section lets you control how a clip triggers when it’s launched.

The Clip Quantization
Chooser.

The Clip Quantization chooser lets you adjust an onset timing correction for clip trig-
gering. To disable clip quantization, choose “None”; to use the Control Bar’s global
quantization setting, choose “Global.”

2.8.8 Launch Modes

The Clip Launch Mode
Chooser.

The Launch Mode chooser offers a number of options for how clips behave with respect
to mouse clicks, computer keyboard actions or MIDI notes:

• Trigger: ‘down’ starts the clip; ‘up’ is ignored.

• Gate: ‘down’ starts the clip; ‘up’ stops the clip.

• Toggle: ‘down’ starts the clip; ‘up’ is ignored. The clip will stop on the next down.
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• Repeat: As long as the mouse switch/key is held, the clip is triggered repeatedly
at the clip quantization rate.

2.8.9 Legato Mode

The Legato Mode Switch.

Suppose you have gathered, in one track, a number of looping clips, and you now
want to toggle among those loops without losing the sync. For this you could use a
large quantization setting (one bar or greater), however, this might limit your musical
expression.

Another option, which works even with quantization turned off, is to engage Legato
Mode for the respective clips. When a clip in Legato Mode is launched, it takes over the
play position from whatever clip was played in that track before. Hence, you can toggle
clips at any moment and rate without ever losing the sync.

Legato Mode is very useful for creating breaks, as you can momentarily play alternative
loops and jump back to what was playing in the track before.

Unless all the clips involved play the same sample (differing by clip settings only), you
might hear dropouts when launching clips in Legato Mode. This happens because you
are unexpectedly jumping to a point in the sample that Live has had no chance to pre-
load from disk in advance. You can remedy this situation by engaging Clip RAM Mode
(see Clip RAM Mode) for the clips in question.
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2.9 Setting Clip Properties

Live’s power as a sound-design tool results from its ability to play a sample, although
static by nature, in many different ways. You can create variation by adjusting the
properties of the clips in your Live Set, which will be covered in this section.

The Clip View.

The Clip View displays the properties of the selected clip.

The Clip View Selector.

The Clip View is opened by clicking on its selector. Alternatively, double-clicking selects
a clip and opens its Clip View.

In the Session View, clicking on a track’s Status field opens the Clip View for editing the
clip that is currently running in the track.



2.9. SETTING CLIP PROPERTIES 56

2.9.1 The Clip View’s Layout

The Clip View’s controls are arranged in boxes:

• The Clip box contains basic clip settings.

• The Sample box contains settings pertaining to which sample the clip plays, and
how it plays the sample.

• The Envelopes box manages the clip’s envelopes, which are used to modulate the
clip, effect and mixer controls (see Animating Samples with Clip Envelopes).

• The remaining part of the Clip View is used for the Sample Display or for the
Envelope Editor. You can toggle between the Sample Display and the Envelope
Editor by clicking in the title bars of the Sample box and the Envelopes box,
respectively. The Show/Hide

Sample/Envelopes Box
Switches.

To make best use of the screen real estate, you can hide and show the Sample box and
the Envelopes box using the little ‘S’ and ‘E’ switches in the Clip box’s title bar.

2.9.2 Basic Clip Settings

The Clip Name Field.

The Clip Name field allows naming the clip. By default, a clip’s name matches the
name of the sample it references but, in general, the clip name is independent from the
sample name.
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Renaming a clip does not rename the referenced sample. To rename a sample, select it
in Live’s File Browsers, and then choose the Edit menu’s Rename command.

The Clip Color Chooser.

The Clip Color chooser allows choosing a clip color.

The Clip Signature Fields.

Using the Clip Signature fields, you can specify the sample’s signature. This setting is
relevant only for display; it does not affect sample playback.

The Quantization (see Real-Time Quantization), Launch Mode (see Launch Modes) and
Legato (see Legato Mode) controls are used for customizing clips for live use.

2.9.3 Warped versus Un-Warped Playback

The Warp Switch.

When the Warp switch is off, Live plays the sample at its original, “normal” tempo,
irrespective of the current Live Set tempo. This is useful for samples that have no
inherent rhythmic structure: percussion hits, atmospheres, sound effects, spoken word
and the like. Turn the Warp switch on to play rhythmically structured samples (such as
sample loops, music recordings, complete music pieces, etc.) in sync with the current
song tempo.
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The Control Bar’s Tempo
Control.

To verify this, note that a warped sample’s speed follows the tempo as you change the
Control Bar’s Tempo control.

Live offers a number of controls to adjust the time-warping engine for optimal stretching
quality (see Adjusting for Good Stretching Quality). For accurate warping, Live needs to
know the sample’s metrical structure. For properly prepared loops, tempo and duration
are calculated automatically; most of the time this is accurate enough that the sample
is immediately ready for use in Live. For other samples, you will have to provide some
hints (see Time-Warping Samples).

2.9.4 Sample Loop / Region

To have the clip’s region played as a (potentially infinite) loop, turn on the Loop switch.
Activating the loop also activates warping; unwarped clips cannot be played as loops.

The Clip Loop Switch.

You can adjust the loop, or region, using the Clip Loop/Region markers in the Sample
Display.

Zooming and scrolling the Clip View’s Sample Display works just like in the Arrangement
(see Arrangement Navigation). Note that you can use the Sample Display itself for zoom-
scrolling. The Clip View selector serves as a sample overview with added zoom/scrolling
functionality.

To move the region or loop, click and drag it left or right. While working in the Sample
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Display, you can also use the up and down arrow keys to move the region or loop
through the sample.

Changing the Region or Loop
End.

To change the region or loop start or end point, drag the left or right edge.

The Offset Marker.

The Offset Marker is visible only if the clip is set to loop. It represents the point in the
sample where the clip starts playing. To adjust this, drag the Offset Marker left or right.
You may have noticed that, as you move the clip loop, the Offset Marker jumps so that
it stays within the loop. If the loop size is set to one, two, four, eight, etc. bars, any
jump remains locked to the rhythm, allowing you to play with the loop in a musical way.
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The Clip Loop/Region
Controls.

The loop or region can also be adjusted numerically using the respective value fields. For
warped clips, these fields display values as bars-beats-sixteenths; for unwarped clips,
the display is in minutes-seconds-milliseconds. The little arrow buttons are useful for
bringing the loop/region’s start, end, offset or complete expanse (length) into view
without zooming or scrolling. If the Start/Position switch is set to Start, values entered
in the respective value fields affect the loop/region’s start point only; if set to Pos,
changing this value moves the complete region/loop.

2.9.5 Clip Pitch

The Clip Transposition Knob.
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The Transpose control shifts the clip pitch in semitones.

The Clip Detune Field.

The Detune field fine-tunes the clip in cents (100 cents = one semitone).

2.9.6 Clip Gain

The Clip Gain Slider.

The Clip Gain slider, calibrated in dB, changes the clip gain.

The Velocity Amount Field.

The Velocity Amount control allows you to adjust the effect of MIDI note velocity on
the clip’s volume: If set to zero, there is no influence; at 100 percent, the softest notes
play the clip silently. For more on playing clips via MIDI, see the respective section
(see Mapping Clips to MIDI Notes).

2.9.7 High Quality Interpolation

The High Quality Switch.
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If the High Quality switch is on, Live uses an advanced sample-rate conversion algo-
rithm that provides better sound quality at the expense of a higher CPU load. Samples
processed with the Hi-Q algorithm generate less distortion, particularly at high frequen-
cies, when transposing a sample and/or matching an imported sample’s sampling rate to
the system’s sampling rate. Note: This feature involves only sample rate conversion, not
the time-stretching quality. There are dedicated controls for adjusting the stretching
properties (see Adjusting for Good Stretching Quality).

2.9.8 Clip Start and End Fades

The Clip Fade Switch.

The Clip Fade switch, when enabled, applies a short fade to the clip start and end to
avoid clicks at the clip edges. The length of the fade is signal-dependent and ranges
from 0-20 milliseconds. Live attempts to start a fade in, or a crossfade, early enough
so that there is no attack smearing at the clip start. Likewise, fadeouts are set up so
that they end with the clip end.

2.9.9 Clip RAM Mode

The RAM Mode Switch.

If the RAM Mode switch is on, Live is loading the audio referenced by the clip into the
computer’s memory rather than reading it from disk in real-time. RAM Mode can help
with these problems:
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• Your computer’s hard disk is too slow to deliver audio for as many tracks as desired
in real-time. For more information on disk-related problems, please refer to the
respective section (see Managing the Disk Load).

• You are experiencing audio drop outs when playing clips in Legato Mode (see
Legato Mode).

Use RAM Mode with care, as RAM is usually a scarce resource. Your computer is using the
hard disk for swapping out RAM contents that have not been used in a while. The more
clips you are running in RAM Mode, the higher the likelihood for them to be swapped
out. Live can handle disk overloads more gracefully than swapped-out audio arriving
late: Disk overloads result in unwanted mutes, whereas RAM overload results in both
mutes and rhythmical “hiccups”.

2.9.10 Replacing the Clip’s Sample

To replace the sample referenced by the clip with a different sample, drop the new
sample directly from the File Browser into the Clip View. All clip settings except the
Warp Markers will be retained.

The Replace Sample Button.

The Replace Sample button is for replacing a sample throughout the entire Live Set. All
clips that reference the “old” sample will reference the “new” sample, which is selected
using a file-chooser dialog. Live retains the clip properties; the Warp Markers (see Time-
Warping Samples) are kept if the new sample has the same or a greater length as the
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old sample and discarded otherwise. This function is also useful for locating missing
samples that are marked “offline” (see Offline and Lost Samples).

2.9.11 Destructive Sample Editing

The Launch Sample Editor
Button.

The Launch Sample Editor button opens the sample in a sample editing application, as
specified in the Misc Preferences. To process a sample in an external program, you will
have to stop Live’s playback. Upon returning to Live, the edited version of the sample
will be played back. The current set of Warp Markers is retained only if the sample
length remains the same as before. Remember that changes to one sample may affect
other clips playing the same sample.

2.9.12 Saving Default Clip Settings with the Sample

The Save Default Clip
Button.

The Save Default Clip button saves the current clip’s settings with the sample. Once
saved, Live will restore the current clip settings whenever you drop the sample into a
Live Set. This is especially useful with regards to the Warp Markers, which have to be
set correctly for Live to play long files in sync. Note that you can use the Save button
without affecting any existing clips; Save just saves default settings for future clips
using this sample. The clip data becomes part of the analysis file (see Analysis Files
(.asd)) that accompanies the sample.
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2.10 Recording Audio

2.10.1 Related Preference Settings

Audio recording requires several preferences to be set up properly. Usually, these things
are set up once for a given hardware setup. Live needs to know:

• The audio driver model in use (see Device Type);

• The audio input device (see Input Device);

• The input buffer size (see Input Buffer Size/Input Latency) which relates to la-
tency (see Managing Audio Latencies);

• Whether or not you are monitoring audio signals through Live (see Monitor Input).

You can save time by setting up reasonable defaults for the clips you are recording (see
Clip Defaults). In particular, it is smart to indicate the rough category of sound to
be recorded by choosing the appropriate default Warp Mode. If you decide later on a
different song tempo, the program will automatically maintain good sound quality (see
Adjusting for Good Stretching Quality), usually without further adjustment.

2.10.2 Recording in Sync

Live keeps the audio you have recorded in sync, even when you later decide on a
different song tempo. In fact, Live allows you to change the tempo at any time before,
after and even during recording. You could, for instance, cheat a bit by turning down
the tempo to record a technically difficult part, and pull it up again afterwards.
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It is important to record in sync to make sure everything will later play in sync.

The Metronome Switch.

The easiest way to record in sync is to set up a simple drum loop to play along with or
to use the built-in metronome, which is activated via its Control Bar switch.

The Pre-Listening Volume
Knob.

To adjust the metronome volume, use the mixer’s Pre-Listening Volume knob.

Notice that Live’s metrical interpretation of the audio being played can be edited, at
any time, using the Warp Markers (see Time-Warping Samples). Warp Markers can be
used to fix timing errors and to change the groove or feel of your recordings. Using
Warp Markers, you can fix things in your recordings that otherwise require complicated
editing or could not be done at all.

2.10.3 Choosing an Audio Input

Let’s select which signal to record; this happens in the Live mixer (see Mixing and
Effects). The Input Type and Channel choosers are available for each track, both in the
Arrangement and Session mixers.

The Input Type, Input
Channel and Output Channel
Choosers.
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The upper/left menu selects the input type or category:

• Live In represents the audio hardware’s physical inputs.

• Master Out is for re-recording Live’s own mixed output.

• All ReWire slave programs you have installed on your computer appear in the
Input Type menu and are available as audio sources for Live. Please refer to the
ReWire section for details (see Connecting via ReWire).

The middle menu selects one of the input source channels, as chosen from the In-
put Type menu. In the “Live In” case, this setting selects your multi-channel audio
hardware’s inputs.

The Bus View Selector.

The available input channels are displayed in the Bus View’s Input tab. You can adjust
a digital gain factor for each input and use the Link switch to set up inputs as stereo
pairs.

The Bus View Displays all
Available Input Channels,
With Gain and Mono/Stereo
Selectors.
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2.10.4 Tape-style Recording
Tape-Style Recording
Happens in the Arrangement
View.

Recording into the Arrangement View is straightforward:

An Arm Recording Switch.

If the Arm Recording switch is on, the track is record-enabled. Of course, you can arm
several tracks at the same time for multi-track recording.

Monitoring the Audio-Ins

Unless a record-enabled track is currently playing a clip, it passes the incoming audio
through the track’s effects and to the output. This “auto-monitoring” behavior can save
you a lot of mouse clicks. If you prefer to monitor the incoming audio all the time,
regardless of the Arm Recording switch and clip playback, press the track’s Monitoring
switch.

A Track Monitoring Switch.

Notice that monitoring is suppressed if the Monitor Input preference (see Monitor Input)
is off. Tracks that receive their input from Live’s own Master output (resampling) cannot
be monitored either.
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Record Start and Stop

The Control Bar’s Record
Button.

If the track is armed for recording, recording will start upon activating the Control Bar’s
Record button and starting playback.

Note that you can toggle playback, recording and the track Arm Recording switches
independently from one another. Using Key Map Mode (see Mapping Clips to Computer
Keys) and MIDI Map Mode (see MIDI Implementation), you can operate Live’s recording
functions without using the mouse by assigning the Record, Play, Stop and Arm buttons.

Loop Recording

The Song Loop Switch.

When you are recording into the Arrangement Loop (see The Arrangement Loop), Live
retains the audio recorded during each pass. You can later “unroll” the loop, either by
repeatedly undoing (see Undo) or graphically in the Clip View: After loop recording,
double-click on the new clip. In the Clip View’s Sample Display, you can see a long
sample containing all audio recorded during the loop-recording process. The Clip View’s
loop marker (see Setting Clip Properties) defines the start of the audio taken in the last
pass; moving the loop marker left lets you audition the audio from previous passes.
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Using Punch Points

Suppose you just recorded the solo of your life - except for one section, which you
would really like to replace. Use the punch points to mark the section to be recorded
over; everything else is left untouched.

The Punch-In Switch.

To prevent recording prior to the punch-in point, activate the Punch-In switch. The
punch-in point is identical to the song loop’s start position.

The Punch-Out Switch.

To prevent recording after the punch-out point, activate the Punch-Out switch. The
punch-out point is identical to the song loop’s end position.

2.10.5 Live Recording

Live Recording Happens in
the Session View.

Live allows you to record new samples during a live jam, without stopping the music.
This happens in the Session View. Make sure the View menu’s “Clips” option is checked.

On the track in which you want to record, choose the audio input type and channel.

The Quantization Chooser.

Choose a quantization setting other than “None” to record perfectly cut samples.
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A Session View Arm Switch.

Activate the Arm Recording switch to record-enable the track. Monitoring is handled as
described above (see Monitoring the Audio-Ins).

A Clip Record Button.

As you activate the track’s Arm switch, you can see record buttons appear in the track’s
empty Session View slots. Clicking on any one of these Clip Record buttons will start
recording.

A Session Clip Being
Recorded.

You will see a new clip appear in the slot. There are now two options:

1. Launch the new clip to jump from recording into loop playback without any in-
terruption;

2. or, click on any Clip Stop button to stop recording without switching to playback.

Using Key Map Mode (see Mapping Clips to Computer Keys) and MIDI Map Mode (see
MIDI Implementation), you can easily prepare mappings for live recording that do not
require using the mouse. One convenient setup uses only two keys on the computer
keyboard to navigate the Session View and initiate recording:

The Scene Up/Down
Buttons.

One key is used to jump to the next scene. . .

A Track Launch Button.
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. . . and another key to start and end recording in the respective track.

Live recording is available in a multi-track scenario as well, as you could use the scenes
to launch many recordings at the same time. Again, it can be useful to pre-configure
which tracks will record new clips in what scenes by adding and removing the slot
buttons (see Add / Remove Slot Button).

2.11 Managing Samples

2.11.1 Renaming and Deleting Samples

You can use Live’s File Browsers to rename and delete files:

• To rename a sample selected in Live’s Browser, choose Rename from the Edit
menu.

• To delete the selected sample(s), choose the Edit menu’s Delete command. Delet-
ing samples within Live moves them to the system trash where they can be re-
covered if needed.

2.11.2 The Sounds Folder and Self-Containing

The Sounds folder is a Live Set’s private location for storing samples. All samples that are
recorded into a Live Set end up in this Live Set’s Sounds folder. Live offers a convenient
method for gathering all samples that are referenced by a Live Set in this folder: When
you choose the File menu’s Save Set Self-Contained command, Live copies all externally
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referenced samples there. After self-containing the files, there are no longer references
to samples spread over one or more hard drives. You can backup the Live Set along with
its Sounds folder, or send them to collaborators via the Internet, and all samples used
in the project will be included.

The Sounds folder for “My Live Set” is called “My Live Set Sounds.” It is located next to
(in the same folder as) “My Live Set.”

2.11.3 Offline and Lost Samples

When loading a Live Set that references samples missing from their referenced locations,
Live issues a warning message and asks whether you want to locate the missing samples.

If you don’t, the Live Set will open anyway, with the missing samples marked “Offline.”
The Live Set will play silence in place of the offline samples. You can find the missing
files by selecting a clip that is referencing an offline sample and clicking the Clip View’s
Replace button (see Replacing the Clip’s Sample).

To avoid missing samples, we highly recommend saving your Live Set as self-contained
(see The Sounds Folder and Self-Containing).

2.11.4 Analysis Files (.asd)

An analysis file is a little file that Live creates when a sample is recorded or dragged into
the program for the first time. The analysis file contains data gathered by the program
to help optimize the stretching quality and speed up the waveform display.
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In addition, an analysis file can store a Default Clip for the sample: Clicking the Clip
View’s Save button will store the current clip’s analysis file with the sample. Next
time the sample is dragged into Live, it will appear with those clip settings. This is
particularly useful for retaining the Warp Marker settings (see Time-Warping Samples)
with the sample.

The analysis file’s name is the same as the associated sample, but with an added “.asd”
extension. Live puts this analysis file in the same folder as the sample. Note that
you can suppress the creation of .asd files by unchecking the Create Analysis Files (see
Create Analysis Files for Samples) option in the Misc Preferences. All data (except for
the Default Clip) can be recreated by Live if the .asd file is missing.

2.12 Time-Warping Samples

Live’s ability to play any audio sample in sync with a chosen tempo is a unique and
important feature. In addition, you can “warp” any sample’s rhythmic flow, which can
change the sample’s “feel” or even move notes to other meter positions.

Think of a sample as a rubber band that you want to pin to a (musical time) ruler. In
Live, the pins are called Warp Markers. A Warp Marker forces the software to arrive at a
specific point in the sample at a specific musical time. You can use any number of Warp
Markers to create an arbitrary mapping of the sample’s inherent rhythm to a musical
meter.

In the following, we will look at a couple of applications.
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2.12.1 Syncing Straight Loops

When you import a sample that represents a well-cut musical loop of 1,2,4 or 8 bars in
length, Live usually makes the correct assumptions to play the loop in sync with the
chosen tempo. It places two Warp Markers, one at the sample’s beginning and one at
the end.

A One-Bar Loop as it
Appears in the Clip View, by
Default.

The “Orig. BPM” field displays Live’s guess of the loop’s tempo. Sometimes Live’s guess
of the original tempo is wrong by half or double. If so, correct this by clicking on the
buttons labeled *2 and :2, respectively. The sample plays at double speed when you
press :2 because you are changing Live’s interpretation of the sample’s tempo, which
serves as a point of reference for determining the required time-stretch factor.

The Reset To Default Button.

The Reset To Default button restores the Warp Marker settings, just as if the sample had
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been dragged into the Live Set over again.

2.12.2 Syncing Uncut Loops

When importing a loop that has not been edited into a well-cut loop, Live will play it
out of sync. Suppose there is a portion of silence at the sample beginning, prior to the
first beat. You can easily correct this by moving the Warp Marker labeled with a “1” to
the first beat’s onset. Likewise, you can eliminate silence after the actual loop end by
moving the Warp Marker at the sample’s right edge.

Setting the Warp Markers for
a Badly Cut Loop.

2.12.3 Syncing Odd-Length Loops

If you import a sample that contains a seven-bar loop, Live initially assumes the loop is
eight bars long (or four, depending on its length) and plays it out of sync. For correct
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playback, the last marker needs to show a seven, not an eight. To achieve this do the
following:

1. Double-click on the last Warp Marker to delete it.

2. Double-click on the seven to create a new Warp Marker.

3. Drag the new Warp Marker to the sample end.

If Live’s initial guess had been a four-bar loop, the seven would not have been acces-
sible. In that case, you could initially drag the Warp Marker at the end toward the left
until the seven became visible.

Theoretically this should have done the job for our seven-bar loop. Practically, though,
it is very likely that moving the markers led to a change of the loop start and end
points. This is because the loop is tied to the meter grid and therefore moves with the
Warp Markers, which define the meter grid. Live makes sure the loop fits in the sample,
and therefore has to change its length if required by a Warp Marker change.

2.12.4 Manipulating Grooves

You can now create any number of Warp Markers by double-clicking on one of the gray
grid markers. Drag in a “straight” looped sample, set a few Warp Markers, and move
them around to see what happens. Warp Markers really serve two purposes:

1. to provide a “correct” interpretation of the flow of musical time in the sample;

2. to mess up the flow of time in the sample.
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If a single event in a percussion loop comes late, just pin it to the Warp Marker, which
shows the beat position at which you actually want to hear that event. You may want
to pin the adjacent beat positions as well, to avoid affecting neighboring regions in the
sample.

Using Warp Markers to
Manipulate the Groove.

2.12.5 Syncing Longer Pieces

Once you are familiar with the basic concept of warping you are ready for a slightly more
complicated task: warping longer pieces.

• Drag a long sample into a Session View slot. When you drag in a sample that
is too long to justify the assumption that it contains a loop, Live will play the
sample “unwarped” by default. Double-click on the clip to view its properties in
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the Clip View. Make sure the Warp switch is off.

• To get a reasonable initial tempo guess for the piece, we will use Live’s tapping
facility (see Tapping the Tempo). Play the unwarped clip, with everything else
muted, and tap along with the beat for a bar or two. Tapping sets the Live Set’s
tempo without affecting the unwarped clip’s playback speed; tapping along with
the unwarped clip syncs Live to the sample’s original tempo.

• Now turn on the Warp switch. Note that the original tempo field shows the same
value as the Control Bar’s tempo field. Live has used the current song tempo as a
guess for the sample’s original tempo.

• Turn on the Clip View’s Loop switch.

• Initially, there is just one Warp Marker (labeled “1”). Drag that marker to where
you believe the first downbeat is. Start playback to test if your assumption
is right; if it is not, move the Warp Marker and try playing it again until you
find the first downbeat. Incidentally, you can zoom in and out around the loop
start (which now coincides with the Warp Marker we are moving) by pressing the
computer’s + and - keys.

The First Downbeat Has
Been Identified.
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• When you have found the downbeat, you are ready to match the tempo. Activate
the metronome. Alternatively, you could drop a simple loop into another track
and play along with that.

• Set the loop length of the clip to be warped to 1, 2 or 4 bars; the easiest way to
do this is to type the value directly into the leftmost Length value field.

• While playing, drag one of the gray markers above the clip waveform horizontally
until the loop sounds in sync with the metronome or your reference loop. Once
this loop sounds right, advance the loop by one loop period. The easiest way to
do this is to press the arrow-up key while the sample is in focus.

Dragging the “2” Marker to
Match the Sample’s Tempo.

• Now, as you listen to the looping sample along with the metronome or your
reference loop, move the gray marker at the loop start to make sure it matches
with respect to the tempo. Use the + and - keys to zoom around the loop start.
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Once it’s right, “pin” the gray marker at the loop start by double-clicking. You
have now created the second Warp Marker.

• Keep moving forward through the sample using the up arrow keys; for each con-
secutive loop position, adjust the gray marker at the loop start, and then pin it
by creating a Warp Marker. Repeat this procedure until you have reached the end
of the sample.

• Now your sample has one Warp Marker per loop period. With a little practice, you
will soon find it is not necessary to create a Warp Marker for every loop position.
If the sample’s tempo is stable, you may use longer loop lengths and set fewer
markers; if the tempo changes very often, you will likely want to use a one-bar
loop, and set a Warp Marker at every bar.

• Once you are done setting Warp Markers, don’t forget to turn off the Loop switch
and to set the region start and end correctly.
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The Result of Setting Warp
Markers for the Piece.

Of course, your Warp Markers will be saved with the Live Set. In addition, you probably
want to save them with the sample, so that they are reconstructed the next time you
drag the sample into Live. To do this, click the Clip View’s Save button (see Analysis
Files (.asd)).

If you frequently warp long pieces, you will learn to set Warp Markers very quickly. Some
Live users prefer different ways to warp, like “real-time warping,” where you set the Warp
Markers in one go, while the complete piece is running unlooped. We found that the
method described above allows for faster-than-real-time warping: You can “loop-hop”
through the sample at any speed desired. Loop-hopping can be an interesting thing to
do in the course of a performance, too!
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2.12.6 Adjusting for Good Stretching Quality

Live offers a number of time-stretching methods to accommodate all sorts of audio
material. The time-stretching method, and additional controls for each method, are set
up in the Clip View’s “Warp” box.

The Warp Modes are different varieties of granular resynthesis techniques. Granular
resynthesis achieves time compression and expansion by repeating and skipping over
parts of the sample (the “grains”). The Warp Modes differ by the selection of grains, as
well as by the details of overlapping and crossfading between grains.

Let’s investigate which Warp Modes work best for different types of signals and how
to adjust the warping controls for “clean” stretching. It’s also fun to “misuse” these
controls to achieve interesting artifacts instead of correct stretching.

Beats Mode

Beats Mode works best for samples where rhythm is predominate (e.g., drum loops as
well as most pieces of electronic dance music). The granulation process is optimized to
preserve transients (attacks, note onsets) in the audio material.

Use the Transients control to guide Live’s assumptions about where to find transients in
the sample. If there is no rhythmical activity at odd 16th notes, choose 8th, etc. For
some interesting rhythmic artifacts, choose large transient values in conjunction with
pitch transposition.
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Tones Mode

Tones Mode serves well for stretching samples with a more or less clear pitch structure,
such as vocals, monophonic instruments and basslines.

Grain Size provides rough control over the average grain size used. The actual grain
size is determined in a signal-dependent way. For signals with a clear sense of pitch
contour, a small grain size works best. Larger grain sizes help avoid artifacts that can
occur when the pitch contour is unclear, but the tradeoff can be audible repetitions.

Texture Mode

Texture Mode works well for complex sound textures with an ambiguous pitch contour
(e.g., polyphonic orchestral music, all sorts of noise, atmospheric pads, etc.). It also
offers rich potential for manipulating all kinds of sounds in a creative way.

The Grain Size control determines the grain size used; unlike in Tones Mode, this is a
setting that Live will use unaltered, without factoring in the signal’s characteristics.

Fluctuation introduces randomness into the process. Larger values give more random-
ness.

Re-Pitch Mode

In Re-Pitch Mode, Live doesn’t really time-stretch or compress the sample; instead, it
adjusts the sample playback rate to create the desired amount of stretching. In other
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words, to speed up the sample by a factor of 2, it’s transposed up an octave. This is
like the “DJ stretching method” of using variable-speed turntables to sync two records,
or what happens to samples in samplers when they’re transposed.

The Transpose and Detune controls have no effect in Re-Pitch Mode.

2.13 Animating Samples with Clip Envelopes

Clip envelopes extend Live’s “elastic” approach to audio and, in conjunction with the
Live effects, turn Live into a mighty sound design tool. Using clip envelopes, you
can create an abundance of interesting variations from the same sample in real-time,
anything from subtle corrections to entirely new and unrelated sounds. Let us first
explain the concept and then look at some uses of clip envelopes.

2.13.1 The Clip Envelope Concept

Every clip in Live contains envelopes to modulate pitch, volume, the warping controls
and the track’s mixer and effect controls. The clip envelopes influence rather than define
the respective control’s value. Every clip envelope has a neutral default setting; unless
you change the envelope, it has no audible effect.

This is an important difference between clip envelopes and the Arrangement’s automa-
tion envelopes (see Automation Envelopes in the Arrangement). An automation en-
velope defines the value of a control across song time in an absolute fashion. A clip
envelope, on the other hand, affects the value in a relative way.
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2.13.2 Clip Envelopes are Non-Destructive

Using clip envelopes, you can create new sounds from a sample without actually affect-
ing the sample on disk. Because Live calculates the envelope modulations in real-time,
you can have hundreds of clips in a Live Set that all sound different, but use the same
sample.

You can, of course, export a newly created sound by rendering (see Exporting Audio
(Render to Disk)), or by resampling (see Recording Audio). In the Arrangement View,
you can use the Consolidate command (see Consolidate) to create new samples.

2.13.3 The Clip Envelope Editor

The Switch with the ‘E’ Label
Brings up the Envelopes Box.

To work with clip envelopes, bring up the Clip View’s “Envelopes” box by activating the
round switch with the ‘E’ label. The Envelopes box contains two choosers for selecting
an envelope to view and edit.
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The Clip View’s Envelopes
Box.

The top menu, the Device chooser, has entries for “Clip” (the clip’s controls), every
effect in the track’s effect chain and the mixer. The bottom menu, the Control chooser,
selects among the controls of the item chosen in the top menu. In both menus, you
can easily identify the items that have a non-neutral clip envelope: Their names are
displayed in red. The “quick-chooser” buttons below the menus select commonly edited
controls.

Clicking the menus or the quick-chooser buttons brings up the Clip Envelope Editor on
the right hand side of the Clip View, instead of the Sample display. You can toggle the
display by clicking in the title bars of the “Sample” and “Envelopes” boxes.

The techniques for drawing and editing clip envelopes are the same as those for
automation envelopes in the Arrangement View (see Automation Envelopes in the
Arrangement).

To delete a clip envelope (i.e. to set it back to its default value), first go to Edit /
Select All, then to Edit / Delete.

Let us now look at some basic uses of clip envelopes.
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2.13.4 Changing Pitch and Tuning per Note

Drop a sample loop from the Browser into Live and play it. Click on the “Transpose”
envelope quick-chooser button. You can now alter the pitch transposition of individual
notes in the sample as you listen to it. The fast way to do this is by enabling Draw
Mode (see Drawing Envelopes) and drawing steps along the grid. Deactivate Draw Mode
to edit breakpoints and line segments. This is useful for smoothing the coarse steps by
horizontally displacing breakpoints.

The Transposition Envelope
with Steps (left) and Ramps
(right).

Note that the warp settings determine how accurately Live’s time-warping engine tracks
the envelope shape. To obtain a more immediate response, reduce the Grain Size value
in Tones and Texture Mode or choose a smaller value for the Transients control in Beats
Mode.

To correct the tuning of individual notes in the sample, hold down the Control (PC) /
Command (Mac) modifier while drawing or moving breakpoints to obtain a finer resolu-
tion.

To scroll the display, hold down the Alt (PC) / Option (Mac) modifier while dragging.
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Pitch is modulated in an additive way. The output of the transposition envelope is
simply added to the “Transpose” control’s value. The result of the modulation is clipped
to stay in the available range (-48..48 semitones in this case).

2.13.5 Muting or Attenuating Notes in a Sample

Click on the “Volume” envelope quick-chooser to access the clip’s volume envelope. By
drawing steps in Draw Mode or creating shapes with breakpoints, you can impose an
arbitrary volume shape onto the sample.

Imposing a Volume Envelope
on a Sample.

The volume envelope’s output is interpreted as a relative percentage of the clip volume
slider’s current value. The result of the clip envelope’s modulation therefore can never
exceed the absolute volume setting, but the clip envelope can drag the audible volume
down to silence.
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2.13.6 Modulating Mixer Controls

Modulating Mixer Volumes and Sends

Notice that there are actually two volume modulations: Clip Volume and Mixer Volume.
The latter is a modulation for the mixer’s gain stage and therefore affects the post-
effect signal. To prevent confusion, a small dot below the mixer’s volume slider thumb
indicates the actual, modulated volume setting.

Modulating the Mixer
Volume. The Little Dot Below
the Volume Slider Thumb
Represents the Modulated
Volume Setting.

As you raise and lower the Volume slider, you can observe the dot following your move-
ment in a relative fashion.

Modulating the track’s send controls is just as easy. Again, the modulation is a relative
percentage: The clip envelope cannot open the send further than the send knob, but it
can reduce the actual send value to minus infinite dB. Modulating a Send. The

Send Knob’s Position Ring
Indicates the Modulated
Value.
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Modulating Pan

The Pan envelope affects the mixer pan stage in a relative way: The pan knob’s posi-
tion determines the intensity of the modulation. With the pan knob set to the center
position, modulation by the clip envelope can reach from hard left to hard right; the
modulation amount is automatically reduced as you move the pan knob towards the left
or right. When the pan knob is turned all the way to the left, for instance, the pan clip
envelope has no effect at all.

Modulating Effect Controls

All effects in a clip’s track are listed in the upper clip envelope Device chooser. Mod-
ulating the effects’ controls works just as you would expect. When modulating effect
controls, it is important to keep the interaction of clip envelopes and effect settings in
mind: Unlike an effects preset (see Using the Live Effects), the clip cannot define the
values for the effects’ controls, it can only change them relative to their current setting
(see The Clip Envelope Concept).

2.13.7 Programming a Fade-Out for a Live Set

A clip envelope can have its own local loop/region settings. The ability to unlink the
envelope from ‘its’ sample creates an abundance of exciting creative options, some of
which we will present in the rest of this chapter.

Let us start with a straightforward example. Suppose you are setting up a Live Set and
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wish to program a fade-out over eight bars to occur when a specific clip is launched–
but all you have is a one-bar loop.

1

2

3

4

5

Using a Clip Envelope to
Create a Fade-Out Over
Several Repetitions of a
Loop.

1. Choose the Clip Volume envelope, and unlink it from the sample. The clip enve-
lope’s loop braces now appear colored to indicate this envelope now has its own
local loop/region settings. The loop/region controls in the Envelopes box “come
to life.”

2. Make sure the clip envelope’s Loop switch is off. Notice the Sample box’s Loop
switch is not affected. The sample will keep looping although the envelope is
now playing as a “one-shot.”

3. Type ‘8’ into the leftmost envelope loop-length value box.

4. Zoom the envelope display out all the way by clicking on the Envelope’s time ruler
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and dragging upwards. (It is actually faster to click the “Show Loop” arrow next
to the loop / region length controls.)

5. Insert a breakpoint at the region end and drag it to the bottom (zero percent).

Now as you play the clip, you can hear the one-bar loop fading out over eight bars.

Please note: toggling Linked Mode changes the envelope data. Toggling back and forth
effectively deletes the envelope data. To return to the previous state, please use Undo.

2.13.8 Creating Long Loops from Short Loops

Let us take this a step further. For a different part of your set, you would like to use the
same one-bar loop – because it sounds great – but its repetition bores you. You would
like to somehow turn it into a longer loop.

We depart from the clip we just set up to fade out over eight bars. Activate the clip
volume envelope’s Loop switch. Now, as you play the clip, you can hear the eight-bar
fade-out repeating. You can draw or edit any envelope to superimpose onto the sample
loop. This, of course, not only works for volume but for any other control as well; how
about a filter sweep every four bars?

Note that you can create as much time as needed in the Clip Envelope Editor, either by
dragging the loop braces beyond the view limit, or by entering values into the numeric
region/loop controls.

You can choose an arbitrary loop length for each envelope, including odd lengths like
3.2.1. It is not hard to imagine great complexity (and confusion!) arising from several
odd-length envelopes in one clip.
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The Sample (left) and
Envelope (right) Loop Offset
Marker.

To keep this complexity under control it is important to have a common point of refer-
ence. The Offset Marker identifies the point where sample or envelope playback depart
from when the clip starts.

Note that the region/loop and Offset markers are subject to quantization by the zoom-
adaptive grid, or by a fixed value (see Using the Editing Grid), as is envelope drawing
(see Drawing Envelopes).

2.13.9 Imposing Rhythm Patterns onto Samples

So far, we have been talking about imposing long envelopes onto small loops. You can
also think of interesting applications that work the other way around. Consider a sample
of a song that is several minutes long. This sample could be played by a clip with a
one-bar volume envelope loop. The volume envelope loop now works as a pattern that
is repeatedly “punching” holes into the music so as to, perhaps, remove every third
beat. You can certainly think of other parameters that such a pattern could modulate
in interesting ways.
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2.13.10 Clip Envelopes as LFOs

If you are into sound synthesis, you may want to think of a clip envelope with a local
loop as an LFO. This LFO is running in sync with the project tempo, but it is also possible
to set up a loop period odd enough to render the envelope unsynchronized:

Quantization and Snapping
Deactivated.

If you deactivate the Snap to Grid switch and set the global Quantization to None, you
can adjust the clip envelope loop start and end points completely independent of meter
grid.

2.13.11 Clip Envelopes as Step Sequencers

Another interesting creative “misuse” of clip envelopes is creating step sequencer-like
patterns. Take, for instance, a one-shot hi-hat sample: Play the sample as a 16th note
length loop, and use a one-bar volume envelope with Draw Mode activated to set the
volume for each step. This obviously is not the usual way to create drum patterns, but
it is a lot of fun anyway!
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Creating a Drum Pattern
Using Clip Envelopes.

2.13.12 Scrambling Beats

One very creative use of clip envelopes is to modulate the sample offset. Sample offset
modulation makes the most sense for rhythmical samples, and is only available for clips
that are set up to run in the “Beats” Warp Mode.

Try sample offset modulation with a one-bar drum loop: Make sure “Beats” Mode is
chosen; in the Envelopes box, choose “Clip” from the Device chooser and “Sample
Offset” from the Control chooser. The Clip Envelope Editor appears with a vertical grid
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overlay. In envelope Draw Mode (see Drawing Envelopes), set steps to non-zero values
to hear the loop scrambled. What is going on?

Imagine the audio is read out by a tape head, the position of which is modulated by the
envelope. The higher a value the envelope delivers, the farther away the tape head is
from its center position. Positive envelope values move the head towards the “future,”
negative values move it towards the “past.” Fortunately, Live performs the modulation
in beats rather than centimeters: A vertical grid line is worth a sixteenth note of offset
and the modulation can reach from plus eight sixteenths to minus eight sixteenths.

Sample offset modulation is the tool of choice for quickly creating interesting variations
of beat loops. We discourage using this technique for “analytical” cut-and-splice tasks;
they are much easier to perform using Live’s Arrangement View, and the results can
easily be consolidated into new clips (see Consolidate).

Repeating Steps and Slowing
Time With the Sample Offset
Envelope.

Some sample offset envelope gestures have a characteristic effect: a downward “es-
calator” shape, for instance, effectively repeats the step at the envelope’s beginning.
Similarly, a smooth ramp with a downwards slope is slowing time and can create nice
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slurring effects when the slope is not quite exactly 45 degrees; try this with a 32th
Transients setting.

2.13.13 Using Clips as Templates

As you are making creative use of clip envelopes, the clips containing them develop a
life of their own, independent of the original sample. You might wonder at a point: What
does this clip sound like with a different sample? This is easy to find out by selecting
the clip so that it is displayed in the Clip View and dragging the desired sample from
one of the File Browsers onto the Clip View. All clip settings, including the envelopes,
will remain unaltered; only the sample will be replaced.

Notice this procedure affects only the selected clip, whereas replacing a sample with the
Clip View’s Replace button (see Replacing the Clip’s Sample) will affect all clips using
that sample.

2.14 Exporting Audio (Render to Disk)

The File menu’s Render to Disk command allows exporting Live’s Master audio output as
a new sample.
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2.14.1 What signal will be rendered?

Render to Disk will always render the signal at Live’s Master output. If you are mon-
itoring the Master output, you can be sure that the rendered file will contain exactly
what you hear. To export individual tracks, deactivate all other tracks other than the
ones you want to export by turning off their Track Activator switches (see Mixing and
Effects) in the mixer.

When Render to Disk is invoked while the Arrangement View is up, Live will render the
selected time range. If you would like to render the current Arrangement loop, choose
the Select Loop command (see Select Loop) from the Edit menu prior to choosing
Render to Disk. Keep in mind that the selection of tracks is irrelevant: The signal to be
rendered is the Master output.

If you choose Render to Disk while the Session View is up, Live will ask you to specify
the length of the sample to be rendered. The Render to Disk dialog will come up with
a Bars:Beats:Sixteenths field where you can type in the length. Live will capture audio
from the Master output starting at the current play start position for whatever duration
you specified.

2.14.2 Rendering Options

The Render to Disk command opens a dialog that offers several rendering options:

• Normalize. If activated, the sample resulting from the render process will be
normalized (i.e., the file will be amplified so that the highest peak attains the
maximum available headroom).
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• Render as Loop. If activated, Live will create a sample that can be used as a loop.
For example, suppose your Live Set uses a delay effect. If Render as Loop is on,
Live will go through the rendering process twice: The first pass will not actually
write samples to disk, but add the specified delay effect. As the second pass
starts writing audio to disk, it will include the delay "tail" resulting from the first
pass.

• File Type, Bit Depth, Sample Rate. These options specify the type of sample to be
created.

• Create Analysis File. If activated, Live will create an .asd file that contains analysis
information about the rendered sample. If you intend to use the new sample in
Live, check this option.

• Convert to Mono. If activated, Live will create a mono file instead of a stereo file.
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The Render Dialog.

2.15 Connecting via ReWire

Live supports the ReWire interface for connecting with another ReWire-compatible audio
program running on the same computer. This is useful if you want to use virtual or
hardware MIDI instruments with Live, as Live is dedicated to audio sequencing.

The ReWire technology, developed by Propellerhead Software, provides ReWire-compatible
programs with:
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• common access to the audio hardware;

• shared transport functionality;

• synchronization to audio word clock and song positioning;

• exchange of audio streams.

The programs in a ReWire connection play distinct roles: The ReWire master accesses
the audio hardware and provides mixing facilities; the ReWire slaves have no direct link
to the audio hardware, but instead send their audio output into the Master’s mixer.

Common ReWire master applications are Digidesign Pro Tools, Steinberg Cubase and
Nuendo, Emagic Logic Audio, MOTU Digital Performer, Cakewalk Sonar and Cycling 74
Max/MSP. Common ReWire slave applications are Propellerheads Rebirth, Propellerheads
Reason, Arturia Storm and Cycling 74 Max/MSP. Live can act as both a ReWire master
and slave.

Note that the ReWire protocol itself does not consume much CPU power. However, as
expected, running two audio-intensive programs on the same computer requires more
resources than running a single program.

2.15.1 Running Live in ReWire Master Mode

Connecting Live to a ReWire slave program is straightforward:
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1
2

3 Feeding Audio From a ReWire
Client Program Into Live.

1. Start up Live first.

2. When Live is up, start the slave program.

3. To pipe audio from the ReWire slave program into one of Live’s mixer tracks, select
the slave program from the Input Type chooser (see Choosing an Audio Input).

4. Choose one of the slave program’s output channels from the Input Channel chooser
below the Input Type chooser; Live displays the inputs as stereo pairs as well as
individual mono channels.

5. Activate track monitoring (see Monitoring the Audio-Ins).

You should now hear the slave program’s audio output through Live. You can use the
Live Effects or VST Plug-ins to process the slave program’s audio and record it into
Live (see Recording Audio). You can use both Live’s and the slave program’s transport
controls to start and stop playback, and to set the song position and tempo.
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Make sure you quit the slave program before quitting Live.

2.15.2 Running Live in ReWire Slave Mode

If you have not used Live yet, please launch Live so that it can install its ReWire engine
in your system.

Live will run in ReWire slave mode if it detects a running ReWire master application at
startup time. Therefore, always start the ReWire master application first, and then start
Live.

Likewise, you will first have to quit Live, then the ReWire master application.

Live’s operation in ReWire slave mode differs from the usual operation in some regards:

• Live will not have direct access to the audio interfaces; audio input/output is
handled by the ReWire master application. No audio input will be available to
Live.

• The sample rate is determined by the host application rather than by Live.

• External synchronization will be disabled (synchronize to the ReWire master ap-
plication instead). Live will not send sync or controller messages to the MIDI
output. Controlling Live via MIDI is still possible.

• Live will not act as a ReWire master application. For instance, you cannot run
Rebirth as a ReWire slave of Live while Live is running as a ReWire slave of Cubase.
You can, however, run both Live and Rebirth as ReWire slaves of Cubase at the
same time.
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2.15.3 More on ReWire

You can find tutorials on connecting Live to specific ReWire master programs at the
ableton tutorial web site.

The ableton FAQ web site is the place to go first if you encounter ReWire-related prob-
lems.

If you cannot seem to find an answer there, please contact the ableton support team.

2.16 Using Live’s Crossfader

Live includes a crossfader that can create smooth transitions between clips playing on
different tracks. Live’s crossfader works like a typical DJ mixer crossfader, except that it
allows crossfading not only two, but any number of tracks– including the sends.

The crossfader is accessed via the Session View mixer.

The Crossfader.

The crossfader is a horizontal slider that can be mapped to any continuous MIDI con-
troller (absolute or incremental).

A Track’s Crossfade Assign
Buttons.

http://www.ableton.com/index.php?main=tutorials
http://www.ableton.com/index.php?main=faq
http://www.ableton.com/index.php?main=support
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Each track has two Crossfade Assign buttons, A and B. The track can have three states
with respect to the crossfader:

• If neither assign switch is on, the crossfader does not affect the track at all.

• If A is on, the track will be played unattenuated as long as the crossfader is in
the left half of its value range. As the crossfader moves toward the right across
the center position, the track fades out. At the crossfader’s rightmost position,
the track is muted.

• Likewise, if B is on, the track’s volume will be affected only as the crossfader
moves left across its center position.

The crossfade-assign section is treated like one control with respect to MIDI mapping;
please see the MIDI mapping section for details (see MIDI Implementation).

It is important to understand that the Crossfade Assign buttons do not affect the sig-
nal routing: The crossfader merely influences the signal volume at each track’s gain
stage. The track can be routed to an individual output bus regardless of its crossfade
assignment. In studio parlance, you can think of the crossfader as an on-the-fly VCA
group.

As with almost everything in Live, your crossfading maneuvers can be recorded into the
Arrangement for later in-depth editing. To edit each track’s crossfade assignment, please
choose “Mixer” from the Envelope Device chooser and “X-Fade Assign” from the Control
chooser. The crossfader’s automation curve is accessible when “Mixer” is chosen from
the Master track’s Device chooser and “Crossfade” is selected from its Control chooser.
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2.17 Computer Audio Issues

Real-time audio processing is a demanding task for general-purpose computers, which
were likely designed to run spreadsheets and surf the internet. An application like Live
requires a powerful CPU and a fast hard disk. This section will provide some insight on
these issues, and should help you avoid and solve problems with running audio on a
computer.

2.17.1 Managing the CPU Load

To output a continuous stream of sound through the audio hardware, Live has to per-
form a huge number of calculations every second. If the processor can’t keep up with
what needs to be calculated, the audio will have gaps or clicks. Factors that affect
computational speed include the processor’s clock rate (e.g., speed in MHz or GHz),
architecture, memory cache performance (how efficiently the processor can grab data
from memory) and system bus bandwidth - the computer’s “pipeline” through which all
data must pass. For this reason, many people involved with pro audio use computers
that are optimized for musical applications.

The CPU Load Meter.

The Control Bar’s CPU meter displays how much of the processor’s computational poten-
tial is currently being used. For example, if the displayed percentage is 10 percent, the
computer is just loafing along. If the percentage is 100 percent, the processor is being
maxed out - it’s likely that you will hear gaps, clicks or other audio problems. Note that
the CPU meter takes into account only the load from processing audio, not other tasks
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the computer performs (e.g., managing Live’s user interface).

Audio calculations have the highest priority in Live. Therefore, even if the CPU shows
a high percentage of processor usage, the audio stream should remain uninterrupted.
However, non-critical functions (such as screen redraws) might slow down because these
tasks are handled only when the audio processing “lightens up” a bit.

CPU Load from Multichannel Audio

One source of constant CPU drain is the process of moving data to and from the audio
hardware. For some audio hardware drivers, this drain can be minimized by disabling any
inputs and outputs that are not required in a project. In those cases, there are buttons
in the Audio Preferences to access the Input and Output Configuration (see Hardware
Setup) dialogs, which allow activating or de-activating individual ins and outs.

Live does not automatically disable unused busses, because the audio hardware drivers
usually produce an audible “hiccup” when there is a request for an audio configuration
change. Therefore, Live offers only the enabled inputs and outputs in the mixer’s bus
selection choosers (see Recording Audio). As these are already “reserved for use,” you
can choose among them while audio is running, without any glitching.

CPU Load from Tracks and Effects

Generally, every track and effect being used in Live incurs some amount of CPU load.
However, Live is “smart” and avoids wasting CPU cycles on tracks and effects that do
not contribute anything useful.
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For example, dragging effects into a Live Set which is not running does not significantly
increase the CPU load. The load increases only as you start playing clips or feed audio
into the effects. When there is no incoming audio, the effects are deactivated until they
are needed again (if the effect produces a “tail,” like reverb and delays, de-activation
occurs only after all calculations are complete).

While this scheme is very effective at reducing the average CPU load of a Live Set, it
cannot reduce the peak load. To make sure your Live Set plays back continuously, even
under the most intense conditions, play back a clip in every track simultaneously, with
all effects enabled.

2.17.2 Managing the Disk Load

A hard drive’s access speed (which is related to, but not identical to, rotational speed)
can limit Live’s performance. Most audio-optimized computers use 7200 RPM or faster
drives. Laptops, to save power, often use 5400 RPM or slower drives, which is why
projects on laptops usually have lower track counts. The amount of disk traffic Live
generates is roughly proportional to the number of audio channels being written or read
simultaneously. A track playing a stereo sample causes more disk traffic than a track
playing a mono sample.

The Disk Overload Indicator.

The Disk Overload indicator flashes when the disk was unable to read or write audio
quickly enough. When recording, this condition causes a gap in the recorded sample;
when playing back, you will hear dropouts.
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Do the following to avoid disk overload:

• Reduce the amount of audio channels being written by choosing mono inputs
instead of stereo inputs, using the Link button in the Bus View (see Recording
Audio).

• Use RAM Mode (see Clip RAM Mode) for selected clips.

• Reduce the number of audio channels playing by using mono samples instead of
stereo samples when possible. You can convert stereo samples to mono using any
standard digital audio editing program, which can be called up from within Live
(see Destructive Sample Editing).

2.17.3 Managing Audio Latencies

The term latency refers to the time it takes for sound from the inputs to become available
to the software and for sound generated or processed by the software to arrive at the
audio outputs.

Latency is an undesirable, yet unavoidable fact of processing audio on a standard com-
puter. All audio software reads and writes audio in chunks, which are collected in
buffers. This is done for the following two reasons:

• to reduce the CPU load;

• to have a “reservoir” of incoming or outgoing audio available for those times
when the processor, even though audio is assigned the highest priority, must
attend to some other task.
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The following methods help you to find suitable latency settings. These adjustments
have to be made only once for a given audio setup, and will be memorized by Live.
However, note that lower latencies add more stress to the CPU. In situations where
adding a few more plug-ins or tracks sends your system “over the edge,” increasing
latency a little bit may allow it to accommodate the extra load.

SoundManager (Mac OS 9’s native audio architecture) works with a preset latency setting
(512 audio samples).

Adjusting the Output Latency

Minimizing output latency is important for getting a quick response from Live to your
actions, particularly when launching clips with the quantization turned off. After all,
when you launch a clip, you want it now — not later. Also, when monitoring audio
input through Live, the output latency contributes to the overall in-to-out delay and
should therefore be as low as possible.

The output latency is adjusted via Live’s Audio Preferences, either using the Output
Buffer Size control (see Output Buffer Size/Output Latency), or using controls offered
by the driver’s setup dialog (see Hardware Setup). Proceed as follows:

1. Set the Output Buffer Size to its maximum value.

2. Load a clip into any one of Live’s tracks and play it. For testing purposes, use a
sustained sound rather than a sound that contains a lot of silence.

3. Insert effects into the track that is playing your test clip until the CPU load (as
displayed in the Control Bar) reaches a level above 70 percent.
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4. Slowly reduce the Output Buffer Size until you can hear dropouts or clicks. Find a
value just high enough that the signal passes through undisturbed.

Adjusting the Input Latency

Reducing the input latency to the lowest workable value is important if you are moni-
toring live input sources through the program.

The input latency is adjusted via Live’s Audio Preferences, either using the Input Buffer
Size control (see Input Buffer Size/Input Latency), or using controls offered by the
driver’s setup dialog (see Hardware Setup). Proceed as follows:

1. First, adjust the output buffer size as described above (see Adjusting the Output
Latency). Start from the setup described.

2. Set the Output Buffer Size to its maximum value.

3. Route an input signal into your test track, and activate monitoring on the track;
you should now hear the input signal being processed by the effects you have
inserted into the track.

4. Slowly reduce the Input Buffer Size until you hear dropouts or clicks. Find a value
just high enough that the signal passes through undisturbed.

Adjusting the Overall Latency

The latency value reported to the software by the audio hardware drivers is not al-
ways completely accurate. The Overall Latency setting is a way to tell Live about any
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deviations from the reported values.

This is important because when recording audio into Live the latency issue is critical.
Live has to move recorded samples in time with the song to compensate for any la-
tencies, and therefore requires precise information about the actual latencies in the
system.

We suggest the following procedure to determine the overall latency, which you will
have to go through only once for a given hardware setup:

1. In the audio preferences, turn off the Monitor through Live switch.

2. Drag an audio cable to short-circuit Live’s output to Live’s input. It does not
matter whether this is an analog or a digital connection; it is important, however,
that you use a “real” hardware connection.

3. Choose a one-shot percussion sample that has a signal peak right at the sample
start, and drag this sample into track 1 of an otherwise empty arrangement. Make
sure the clip starts exactly at the song start.

4. Set up track 2 for live audio in, such that it receives Live’s output signal.

5. Arm track 2 and record a couple of seconds of audio.

6. Now, track 2 contains an approximate copy of the clip in track 1, delayed by an
amount of time that corresponds to the overall latency.

7. Double-click the new clip; in the Clip View, turn off the Warp switch.

8. Move the region start marker to the right. In the Arrangement display, you can
observe the percussion hit’s waveform in track 2 moving left. Keep moving right
until the percussion hit reaches the song start (zoom in if needed to get as close
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a match as possible). You have now offset the region start of the clip in track 2
to compensate for the delay between the original and the copy.

9. From the Clip View’s Start value boxes, read out the value in milliseconds. Type
this value into the Audio Preference’s Global Latency field.

If desired, you can delete the recording from track 2 and repeat the test above to verify
that there is no offset between the original clip in track 1 and the recorded copy in
track 2.

Monitoring and Latency

To make sure that the samples you are recording into Live will later play in sync,
Live compensates for the latencies involved. To do this correctly, it needs to know
whether you are monitoring live audio sources through the software or through external
equipment (or not at all).

Therefore, make sure that the Monitor through Live (see Monitor Input) switch in the
Audio Preferences matches your actual monitoring setup.



Chapter 3

Live Reference

3.1 Live Preferences

The Preferences dialog contains several settings that control Live’s operation. To open
the Preferences dialog window, select “Preferences” from the Options menu (or the Live
menu in OSX). You can access the Live main window at any time while the Preferences
dialog is open. Preferences settings are saved with the application. Loading and saving
Live Sets does not affect the Preferences settings.

115
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3.1.1 Misc Preferences

The Misc(ellaneous) Preferences control various aspects of Live’s behavior and appear-
ance.

Clip Update Rate

The Clip Update Rate is the rate at which Live updates a running clip’s settings. Play a
clip from the Session View and open the Clip View to access the clip’s settings. If you
change any of the settings (Transposition, for instance), your changes are quantized by
the rate selected from the Clip Update Rate chooser.

When you change a running Session View clip’s controls while the Control Bar’s Record
switch is on, Live creates copies of the clip at the selected Clip Update Rate and puts
them into the Arrangement. For details on recording sessions, refer to the relevant
section in the Guided Tour (see Recording Sessions into the Arrangement).

Create Analysis Files for Samples

Live analyzes every sample upon loading. The analysis data speeds up the waveform
display and improves the time warping engine’s operation. When the Create Analysis
Files for Samples switch is turned on, the analysis results are stored in an analysis file.
Upon dragging this file into a Live Set, Live reads the analysis data from the analysis
file instead of running the analysis again.



3.1. LIVE PREFERENCES 117

The analysis file resides in the same directory as its associated sample and uses the
same name with an “.asd” extension. The analysis file is very small when compared to
the sample. However, if you want to prevent Live from filling your disk with .asd-files,
uncheck “Create Analysis Files for Samples." For more information on files used and
created by Live, refer to the “Managing Samples” section (see Managing Samples).

Record File Type

This specifies the type of sample files created by Live when recording new audio (see
Recording Audio). The sample rate is set by the output sample rate (see Sample Rate).

Record Bit Depth

This specifies the bit depth of sample files created by Live when recording new audio
(see Recording Audio). The sample rate is set by the output sample rate (see Sample
Rate).

Select on Launch

By default, clicking a Session View clip’s play button also selects the clip, since you
will typically want the Clip View to show the newly launched clip. However, some
power-users don’t want the current focus (e.g., a Send Track’s effects) to disappear just
because a clip has been launched, especially when starting a clip in order to try it with
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the send effect settings. Turn off this preference if you prefer the view to remain as is
when you launch clips or scenes.

Load Skin

Selects among a set of “skins” (color schemes) for Live’s user interface.

Choose Language

Selects the system language. This also affects the Info View (see Getting Help from the
Info View) mouse-over help.

VST Plug-in Folder

Click the “Browse” button to locate the folder containing VST Plug-ins. Live seeks VST
Plug-ins in the selected folder and displays the available ones in the Plug-In Effects
Browser (see Using the Live Effects). For more on working with VST Plug-ins, please see
the respective section (see Using VST Plug-Ins).

Audio Record Folder

Click to select the Audio Record Folder. This is the disk location where Live will put
the samples you record into an unnamed Live Set. When the Live Set is saved, Live will
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attempt to move (space permitting) all samples from the temporary record folder to the
saved Live Set’s Sounds folder (see The Sounds Folder and Self-Containing).

Choose Sample Editor

Click to select a sample editor application that will open upon clicking the Clip View’s
Edit button (see Destructive Sample Editing).

3.1.2 Default Preferences

The Default Preferences determine the initial state of newly created Live Sets and clips.

Save Template

Clicking will save the current Live Set as a template Live Set. Live will use these settings
as the initialized, default state for new Live Sets. You can use this to pre-configure:

• Your multi-channel input/output setup.

• Preset effects, like EQs and Compressors, in every track.

• Computer key mapping.

• MIDI mappings.
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The template Live Set “Template.als” is located in Live’s Preferences folder and can be
copied or deleted from there. The easiest way to locate this folder is to search your disk
for Template.als.

Clip Defaults

The controls in the Clip Defaults part of the Defaults tab specify the initial values for
clips that are created when dragging samples from disk into a Live Set.

The Loop/Warp chooser selects the defaults for the Warp and for the Loop switch. When
“Auto” is chosen, Live makes a guess based on the sample’s length.

Auto-Assign Colors to Clips/Default Clip Color

Live will assign random colors to new clips if the Auto-Assign Colors to clips switch is
on. Otherwise, new clips are the color selected from the Default Clip Color chooser.

3.1.3 Audio Preferences

The Audio Preferences settings manage audio input and output.
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Device Type

The Device Type chooser selects among audio drivers available on your computer. Live
supports:

• SoundManager (under Mac OS 9)

• Core Audio (under Mac OS X)

• DirectX/MME (under Windows)

• ASIO (under Windows and Mac OS 9)

• Direct I/O (Digidesign’s proprietary audio architecture)

Whether several of the settings described below are present or not depends on the
chosen Device Type.

Windows only: Usually, ASIO drivers are the preferred choice because they allow for
lower latency times (see Managing Audio Latencies). ASIO drivers are available for
almost every professional audio I/O interface. Check with your audio hardware’s vendor
if you are unsure whether your interface supports ASIO.

Hardware Setup

Opens the driver’s control panel for driver-specific settings.
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Input Configuration

Brings up a dialog for enabling and disabling the individual stereo input pairs offered
by the chosen driver. Disabling the unused inputs saves CPU load (see CPU Load from
Multichannel Audio).

Output Configuration

Brings up a dialog for enabling and disabling the individual stereo output pairs offered
by the chosen driver. Disabling the unused outputs saves CPU load (see CPU Load from
Multichannel Audio).

Input Device

Use the Input Device chooser to choose among the available audio input devices that
match the Device Type setting.

Input Buffer Size/Input Latency

The Input Buffer Size setting determines the delay between the time an audio signal
appears at the audio hardware’s inputs and when it becomes available to the software.
This delay is called input latency. For further information on latencies, and on setting
up this preference, please see the Managing Latencies section (see Managing Audio
Latencies).
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If this control is missing, click the Hardware Setup button to access the device’s specific
setup dialog. For further information, please refer to your audio hardware’s documenta-
tion.

Monitor Input

Set this switch to inform Live about your recording setup. Here are the rules:

• If you connect your audio sources directly to Live, this switch must be on so you
can monitor the sources. A typical scenario would be recording a piece of music
from a record player into Live, with the preamp’s output connecting directly to
the computer’s input.

• If you monitor your audio sources through an outboard mixing console, or if you
do not monitor at all, the switch should be turned off. This would typically be
the case if you are singing or playing an instrument, or working with musicians
in a recording or stage environment.

• If your audio hardware offers “Zero-Latency-Monitoring,” and you are making use
of this option, this switch should also be turned off. For further information,
please refer to your audio hardware’s documentation.

When singing or playing instruments into Live, monitoring through the computer will
be acceptable only with low-latency (see Managing Audio Latencies) audio hardware
and associated drivers. An overall latency of a few milliseconds is not objectionable
(a latency of 3 ms delays audio by approximately the same amount as moving your
ears 1 meter further from a speaker), but latencies greater than 10-15 ms are definitely
annoying.
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Output Device

Use the Output Device chooser to choose among the available audio output devices that
match the Device Type setting.

Output Buffer Size/Output Latency

The Output Buffer Size setting determines the delay between an audio signal being
generated in Live and the signal becoming available at the audio hardware’s outputs.
This delay is called output latency. For further information on latencies, and on setting
up this preference, see the Managing Latencies section (see Managing Audio Latencies).

If this control is missing, click the “Hardware Setup” button to access the device’s
specific setup dialog. For further information, please refer to your audio hardware’s
documentation.

Sample Rate

Use the Sample Rate setting to choose the sampling rate at which Live generates and
outputs audio.

Because Live performs a real-time sample-rate conversion, samples with arbitrary sam-
pling rates can be read, no matter which output Sample Rate you have selected. How-
ever, the sampling rate of samples recorded in Live will always be identical to the output
Sample Rate.
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Depending on the selected Device Type, the sampling rate may be fixed (usually at
44,100 Hz).

Overall Latency

This setting is described in detail in the section on Adjusting the Overall Latency (see
Adjusting the Overall Latency).

Master

The Master chooser selects an output bus for Live’s master track. The number of available
busses depends on the selected Output Device. The bus used for the Master will not be
available as a separate output destination for the tracks.

Pre-Listen

Selects the output bus to be used for pre-listening. The menu offers all available busses
except the bus that is used for the Master.

If the chosen Output Device supports only one stereo out, this menu and the Option
menu’s PFL switches entry (see PFL Switches) will appear disabled.
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3.1.4 MIDI Preferences

MIDI Remote Control Input

The MIDI Remote Control Input Device choosers select the MIDI devices from which
Live will receive MIDI notes and controller messages. Live merges the MIDI coming in
through the two devices.

The MIDI In Indicator

When Live recognizes a MIDI message, the MIDI In Indicator next to the CPU Load meter
in the Control Bar flashes.

MIDI Remote Control Output

This selects the MIDI device to which Live sends MIDI controller messages. This is useful
when working with external controller boxes that use endless knobs or motorized faders.
These devices need to be updated when a control’s value changes in Live, because the
position of the motorized faders or LED chains has to match the new value.

Send Control Updates Now

Sends the current state of all of Live’s controls. Use this to bring an external device up
to date after connecting it to the computer.



3.1. LIVE PREFERENCES 127

MIDI Input Sync

The MIDI Sync Input device chooser selects the MIDI device from which Live receives
its MIDI sync messages.

The External Sync Switch.

Activate External Sync by switching on the EXT button in the Control Bar.

The External Sync Indicator.

The External Sync indicator next to the EXT button flashes if Live receives useable sync
messages.

MIDI Input Sync Type

This chooses the type of sync messages to which Live will respond. The choices are:

• MIDI Clock. MIDI Clock works like a metronome ticking at a fast rate. The rate of
the incoming ticks is tempo-dependent: Changing the tempo at the sync source
(e.g., a drum machine) will cause Live to follow the change. The MIDI Clock
protocol also provides messages that indicate the song position.

• MIDI Timecode. MIDI Timecode is the MIDI version of the SMPTE protocol, the
standard means to synchronize tape machines and computers in the audio and
film industry. A MIDI Timecode message specifies a time in seconds and frames
(subdivisions of a second). Live will interpret a Timecode message as a position in
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the Arrangement. Timecode messages carry no meter-related information; when
slaving Live to another sequencer using MIDI Timecode, you will have to adjust
the tempo manually. Tempo changes cannot be tracked.

When synchronising Live from an external sync source, the latency issue (see Manag-
ing Audio Latencies) becomes particularly relevant: Live’s output may sound delayed
compared to the sync source’s output. Live “knows” its output will arrive at the au-
dio interface delayed by the audio output latency. It will therefore pre-delay its clock
to compensate for the audio output latency. This may not suffice, however, for two
reasons:

• some audio interfaces add latency that Live cannot detect;

• it takes some time for the MIDI sync messages to reach Live.

The Latency Compensation control allows offsetting Live’s internal clock so that Live and
the sync master will play together in sync. To adjust the Latency Compensation, have
both Live and the sync source play a rhythmical pattern with pronounced, percussive
sounds. While listening to the output from both the sync master and Live, adjust the
Latency Compensation control until both sounds are in perfect sync. Usually, you will
have to make this adjustment only once for any given studio setup.

MIDI Timecode Frame Rate

This setting is relevant only if “MIDI Timecode” is chosen from the MIDI Input Sync
Type menu.

The MIDI Timecode Frame Rate chooser selects the type of Timecode to which Live will
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synchronize. All of the usual SMPTE frame rates are available. When the Frame Rate is
set to “SMPTE All,” Live auto-detects the time code format of incoming sync messages,
and interprets the messages accordingly. Note that you can adjust the time code format
that is used for display in the Arrangement View: Go to the Options menu, then access
the Time Ruler Format sub-menu.

MIDI Timecode Start Offset

This setting is relevant only if “MIDI Timecode” is chosen from the Sync Type menu.

You can specify a SMPTE time offset using the MIDI Timecode control. Live interprets
this value as the Arrangement’s start time.

3.2 The Live Menu

3.2.1 The File Menu

New

. . . opens a new Live Set.
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Open

. . . opens an existing Live Set. Live Sets can also be located using the built-in File
Browsers and opened from there by double-clicking.

Close

. . . closes the Live Set which is currently open.

Save

. . . saves the current Live Set.

Save As

. . . saves the current Live Set under a different name and/or in a different directory
location.

Save a Copy

. . . saves a copy of the current Live Set with a new name and/or new location, but does
not replace the current Live Set. Useful for saving multiple versions of a Live Set.
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Save Self-Contained

. . . saves the current Live Set and copies all externally referenced samples into the
Live Set’s Sounds folder. For details, refer to the section on the Sounds folder and
self-containing. (see The Sounds Folder and Self-Containing).

Render to Disk

. . . brings up the Render dialog for exporting your work as a new sample. (see Exporting
Audio (Render to Disk))

Quit

. . . quits the program.

3.2.2 The Edit Menu

Undo

. . . undoes the previous action, thereby restoring the state of the Live Set to what it
was previously. This command can be used repeatedly, as Live maintains a “history” of
the actions carried out on a Live Set. Use the Redo command (see Redo) to return to
the Live Set’s state prior to invoking Undo. Using Undo and Redo, you can freely move
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back and forth in the Live Set’s edit history. Note, however, that after performing any
action other than Redo after Undo will make Live “forget” the undone edit steps.

Redo

The action that was last undone (see Undo) is redone.

Cut

. . . removes the selected material. Cut material is placed on the clipboard and can be
pasted at any place within the same Live Set, or another Live Set. In the Arrangement
View, Cut not only removes the clips, but also all automation in the selected time span,
unless the Lock Envelopes switch (see Editing Breakpoints) is on.

Cut Scenes

. . . cuts out scenes with selected slots from the Session View, thereby reducing the total
number of scenes. Please note that the Cut Scenes command affects all tracks, not only
those containing selected slots.
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The Session View Before and
After Executing the Cut
Scenes Command.

Cut Time

. . . cuts a selection of time from the Arrangement, thereby moving any audio on either
side of the cut area closer together in the timeline. This command reduces the length
of your Arrangement by whatever amount of time you have cut. Note that the Cut Time
command affects all tracks, not only the selected ones.
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A Gap Between Clips Has
Been Deleted by First
Selecting it, Then Executing
the Delete Time Command.

Cut Envelope

. . . allows you to cut a selection of the breakpoint envelope currently displayed in the
track. The selected piece of the envelope is copied to the clipboard and can be pasted,
using the Paste command, anywhere in the same track or in another track. The envelope
breakpoints are removed from the original envelope selection.
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Cutting Part of an Envelope.
Notice the Clip Remains
Unaffected.

Copy

. . . makes a copy of the selected material and places it on the clipboard. In the Ar-
rangement View, Copy not only copies the clips, but also all automation in the selected
time span.

Copy Envelope

. . . allows you to copy any section of a breakpoint envelope. This command differs from
the Copy command in that it only copies the displayed envelope, and no clips or other
automation.



3.2. THE LIVE MENU 136

Paste

. . . pastes the material from the clipboard at the selected location. Material from the
clipboard will be pasted into place regardless of the current selection’s size and content.
Clips copied from the Arrangement View into the Session, and vice versa, retain their
temporal/spatial order.

Paste Time

. . . places copied time into the Arrangement, thereby increasing its overall duration by
the length of time you have copied.

Paste Scenes

. . . works like Paste, but inserts blank scenes before pasting. Live inserts enough scenes
to fit the material from the clipboard. The new scenes will be inserted behind the
current selection.

Duplicate

. . . automatically copies and pastes a selection. This is an easy way to make multiple
copies of a clip or selection of clips. In the Session View, the copies are put into the
slots which follow the selected slots. In the Arrangement View, the copies are put
behind the selection, into the “future” of the Arrangement.
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Creating Repetition With the
Duplicate Command.

Duplicate Time

. . . places a copy of the selected time span into the Arrangement, thereby increasing its
overall duration by the length of the selection.

Duplicate Scenes

. . . works like Duplicate, but inserts blank scenes before pasting. Live inserts enough
scenes to fit the material from the clipboard.

The Session View Before and
After Executing the
Duplicate Scenes Command.
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Duplicate Envelope

. . . duplicates the selected portion of the breakpoint envelope into the Arrangement’s
“future.” Duplicate Envelope can create repeating control movements.

Duplicating Part of an
Envelope. Notice the Clip
Remains Unaffected.

Delete

. . . erases any selected items. Delete differs from the Cut command in that deleted
items are not placed on the clipboard and cannot be pasted back into place (though
you can undo any command at any time).

If the Delete command is executed while files or folders are selected in the built-in File
Browsers, Live will move these items to the system trash. You cannot undo this action
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from within Live, but you can retrieve the files from the system trash via the Explorer
(Windows) / Finder (Mac).

Delete Scenes

. . . deletes all scenes with selected slots from the Session View, thereby reducing the
total number of scenes. Please note that the Delete Scenes command affects all tracks,
not only those containing selected slots.

Delete Time

. . . deletes a selection of time from the Arrangement, thereby moving any audio on
either side of the deleted area closer together in the timeline. This command reduces
the length of your Arrangement by the amount of time you have deleted. Note that the
Delete Time command affects all tracks, not only the selected ones.

Delete Envelope

. . . allows you to delete all breakpoints within the selection from the breakpoint enve-
lope that is currently displayed.
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Delete Automation

. . . allows you to delete the automation for the selected control. All breakpoints of the
control’s envelope will be deleted.

Insert Scene

. . . inserts an empty scene below the current selection.

The Session View Before and
After Executing the Insert
Scene Command.

Insert Captured Scene

The Insert Captured Scene command does three things at once:

1. inserts a new scene below the current selection;

2. places copies of the clips that are currently running in the new scene;

3. launches the new scene immediately with no audible interruption.
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The Session View Before and
After Executing the Insert
Captured Scene Command.

This command is very helpful when developing materials in the Session View. You can
capture an interesting moment as a new scene and move on changing clip properties
and trying clip combinations.

Insert Silence

. . . inserts as much empty time as is currently selected into the Arrangement, before the
selection.

Insert Track

. . . adds one more clip track to the Live Set.

Insert Send Track

. . . adds one more send track to the Live Set.
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Rename

. . . allows you to rename the selected track, scene or file. Proceed as follows:

1. select the item you want to rename (by clicking on it, for instance);

2. call up Rename to enter text-edit mode;

3. type the new name;

4. press the Return key to confirm the new name,

5. OR press the Escape key to discard the new name,

6. OR press the Tab key to confirm the new name and proceed to rename the next
track, scene or file.

Split

The Split command can divide a clip or isolate part of it.

To split a clip in two halves,

1. unfold the track (see Editing Audio Waveforms);

2. in the waveform display, click at the position where you want the clip to be split;

3. execute the Split command.

To isolate a part of a clip,

1. unfold the track (see Editing Audio Waveforms);
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2. in the waveform display, drag a selection over the part of the clip you want to
isolate;

3. execute the Split command to divide the original clip into three pieces.

The Result of Splitting a
Clip.

Consolidate

The Consolidate command replaces the material in the Arrangement View selection with
one new clip per track. This is very useful for creating structure.

Consolidating Several Clips
Into a New Looping Clip.
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Suppose you have, by editing or improvising, come up with a layout of clips that sound
good in Arrangement Loop Mode (see The Arrangement Loop). Selecting that part of the
Arrangement, for instance by using the Select Loop command (see Select Loop), and
then executing the Consolidate commands creates a new clip that can be treated as a
loop. You can now, for instance, drag the clip edges to create more repetitions. You
might also want to drag the new loop via the Session View selector into a Session View
slot for real-time arrangement purposes.

Consolidate actually creates a new sample for every track in the selection. The new
samples are essentially recordings of the time-warping engine’s audio output, prior to
processing in the track’s effect chain and mixer. Hence, the new sample incorporates
the effects of in-clip attenuation, time-warping and pitch shifting, and of the respec-
tive clip envelopes (see Animating Samples with Clip Envelopes); however, it does not
incorporate the effects. To create a new sample from the post-effects signal, please use
the Render to Disk command (see Render to Disk).

The new samples can be found in the “Sounds” folder, a disk location specific to the
Live Set in which you are working. Please see the section on managing samples (see
Managing Samples) for more information.

Add / Remove Slot Button

. . . will add/remove the slot buttons from the selected Session View slots. A slot button
serves two different purposes depending on whether a track is record-enabled (see
Recording Audio) or not:

• If the track is not record-enabled, clicking the slot button will stop the clip
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currently running in the track and disable all track automation.

• If the track is record-enabled, the slot button turns into a record button; click it
to initiate the recording of a new clip.

The slot buttons are particularly relevant when working with scenes. Since launching
a scene is equivalent to clicking all clip and slot buttons in that scene simultaneously,
you can pre-configure what will happen upon scene launch by adding and removing slot
buttons. If, for instance, you don’t want scene 3 to affect track 4, simply remove the
scene 3 / track 4 slot button.

Loop Selection

. . . turns the Arrangement loop on and sets the Arrangement Loop/Region markers to
match the selected time span.

Select Loop

. . . automatically selects all Arrangement time within the Arrangement Loop/Region
markers. This is useful if you have edited an Arrangement within the Loop/Region
markers that you (or your audience!) find particularly compelling. You can select it
all with the Select Loop command to Duplicate (see Duplicate) or Copy (see Copy) and
Paste (see Paste) it or to Render (see Exporting Audio (Render to Disk)) it to a new
sample.
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Select All

In the Arrangement, Select All selects the time in all tracks, from the beginning of the
first clip to the end of the last clip.

Use the Select All command prior to rendering (see Exporting Audio (Render to Disk)) to
render the complete Arrangement as a new sample. To accommodate effects like reverb
or delay that may persist after the end of the tune, you can extend the selection beyond
the last clip in the Arrangement by shift-clicking.

In the Session View, Select All selects all slots in all tracks.

In the Clip Envelope Editor, Select All selects the entire envelope, from the first to the
last breakpoint. If the Delete command follows Select All, all breakpoints are removed
and the envelope goes back to its neutral default state.

3.2.3 The View Menu

Full Screen

. . . toggles Full Screen Mode.

The Exit Full Screen Button.

To leave Full Screen Mode, click the button that appears in the lower right corner of the
screen.
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Under Windows, you can access each menu by pressing the first letter of the menu with
the Alt-modifier held (Alt-F for “File”, for instance). While a menu is open, you can use:

• the arrow up and down keys to navigate the menu items;

• the arrow left and right keys to open the neighboring menu;

• the Return key to choose a menu item.

Show / Hide Plug-In Windows

. . . shows or hides all open VST Plug-in windows at once. For more information on
handling VST Plug-in windows, please see the respective section (see Showing Plug-In
Panels in Separate Windows).

Commands for Opening / Closing Views

The following commands make Live’s views appear and disappear:

• Info

• Arrangement

• Session

• Clip

• Track
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• Bus

• Live Effects

• Plug-In Effects

• Files 1

• Files 2

• Files 3

The commands below hide/show mixer components. You can use different mixer view
setups in the Session View and in the Arrangement View.

• Overview (cannot be hidden in the Arrangement)

• Clips

• Crossfader

• In/Outs

• Sends

• Mixer

3.2.4 The Options Menu

Edit MIDI Map

Activates MIDI Map Mode (see MIDI Implementation) for assigning MIDI keys/controllers.
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Edit Key Map

Activates Key Map Mode (see Mapping Clips to Computer Keys) for assigning controllers
from your computer’s keyboard.

External Sync

Check External Sync to synchronize Live to an external sequencer. A number of sync
options are available from the MIDI Preferences (see MIDI Preferences).

Time Ruler Format

This selects the time display format used by the Arrangement View’s time ruler.

Quantization

A clip launched from the Session View will be quantized according to this setting unless
its own quantization settings (see Real-Time Quantization) specify otherwise.

The Quantization Chooser.

This setting is reflected by the Control Bar’s Quantization chooser.
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Snap to Grid / Quantization

Choose Snap to Quantization to make the mouse snap to the fixed quantization grid that
has been selected in the Option menu or in the Control Bar’s chooser.

Choose Snap to Grid Lines to make the mouse snap to grid lines that represent meter
subdivisions of the song tempo. This grid adapts to the zoom level.

The Arrangement’s Snap to
Grid Switch.

This setting is reflected by the Arrangement’s Snap to Grid switch.

Envelope Draw Mode

When Draw Mode is enabled, automation and clip envelope curves can be drawn into the
Arrangement View and Envelope Editor, respectively. Drawing will appear in steps that
are as wide as the visible gridlines if Snap to Grid is on. If Snap to Grid is off, drawing
is dependent on the global quantization setting.

Lock Envelopes

The Lock Envelopes command locks automation to a specific Arrangement position, so
that it does not move along with clips when they are relocated. If this command is off,
automation will move when clips are moved.



3.2. THE LIVE MENU 151

Follow

When the Follow command is activated, the display will scroll while playing to always
show the current position in time. Follow is automatically turned off when you scroll,
zoom or change the selection.

The Arrangement’s Follow
Switch.

This setting is reflected by the Arrangement’s Follow switch.

Solo Switches

This is the default setting for the mixer’s Solo switches’ operation: Soloing a track mutes
all other tracks. The signal from the soloed tracks is heard through their respective
outputs, with the pan setting of each track preserved. Soloing a clip track leaves the
send tracks unaffected (solo in place). Soloing a send track affects all other tracks.

PFL Switches

Using this option, you can pre-listen tracks as though you were cueing a record on a DJ
mixer. This allows choosing clips and adjusting effects without the audience hearing,
before bringing tracks into the mix.

Pressing a track’s Solo switch will route the track’s output signal, tapped before the
mixer volume control (pre-fader), to the audio output you have assigned for pre-
listening (see Pre-Listen). No other tracks will be affected.
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The PFL switches option can be chosen only if your audio configuration supports multiple
outputs.

Note that you can adjust your headphone output level using the mixer’s (see Mixing and
Effects) headphone control.

Preferences

Brings up the Preferences dialog (see Live Preferences).

3.2.5 The Help Menu

Read the Live Manual

. . . opens this PDF document.

Visit ableton.com

. . . launches the web browser with the ableton home page, which offers product news,
artist interviews, interesting downloads and much more.
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Join the User Forum

. . . launches the web browser with the ableton user forum, the online venue for dis-
cussing music, software and Live specifics.

Talk to ableton

. . . opens an email template for sending your idea, suggestion, wish, clever joke, inter-
esting story or complaint directly to the makers of Live.

Get Support

. . . launches the web browser with the ableton user support pages. Should you require
help on any issue regarding your ableton product, please follow this link.

Check for Updates

Check this link regularly to determine if a Live update is available.

Get the Full Version of Live (Demo and Special Edition only)

. . . launches the web browser with the ableton online shop, where you can learn about
and purchase the full version of Live.
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3.3 The Live Effects

Live comes with a selection of custom-designed, built-in effects. The “Mixing and
Effects” section (see Mixing and Effects) explains the basics of using effects in Live.

3.3.1 Auto Filter

The Auto Filter Effect.

The Auto Filter effect provides classic analog filter emulation. It can be modulated by
an envelope follower and/or an LFO to create moving filter effects.

There are four different filter types: low pass, high pass, band pass and band reject
(notch). For each type, the X-Y controller adjusts frequency (to adjust, click and drag
on the X-axis) and Q (also called resonance; to adjust, click and drag on the Y-axis).
You can also click on the Freq and Q numeric displays and type in exact values.

Low Q values create a broad filter curve, while higher values introduce a narrow, resonant
peak to the sound. In Band Pass/Reject Mode, Q sets the bandwidth of the passed or
rejected signal.
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The Quantize Beat control applies quantized modulation to the filter frequency. With
Quantize Beat off, frequency modulation follows the control source. Turning this feature
on updates the filter modulation rhythmically with “stepped” changes that track the
master tempo. The numbered buttons represent 16th notes, so, for example, selecting
4 for Beat value produces a modulation change once per beat.

The EnvelopeMod section controls how the envelope modulation affects the filter fre-
quency. The Mod control defines the extent to which the envelope affects the filter
frequency, while the Attack control sets how the envelope responds to rising input sig-
nals. Low Attack values cause a fast response to input levels; high values integrate any
changes gradually, creating a looser, slower response. Think of it as adding inertia to
the response.

Lower Release values cause the envelope to respond more quickly to falling input sig-
nals. Higher values extend the envelope’s decay.

The Auto Filter also contains a Low Frequency Oscillator to modulate filter frequency in
a periodic fashion. The Amount control sets how much the LFO affects the filter.

The Rate control specifies the LFO speed.

Available waveform shapes are Sine (creates smooth modulations with rounded peaks
and valleys), and Sample and Hold (generates random positive and negative modulation
values).

There are two sine wave LFOs, one for each stereo channel. The Phase and Spin controls
define the relationship between these two LFOs.

Phase keeps both LFOs at the same frequency, but can set the two LFOs’ waveforms “out
of phase” with each other, creating stereo movement. At maximum, the LFO outputs are
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180 degrees apart, so that when one LFO reaches its peak, the other is at its minimum.

Spin detunes the two LFOs’ speeds relative to each other. Each stereo channel is modu-
lated at a different frequency, as determined by the Spin amount.

For sample and hold, the Spin and Phase controls are not relevant and do not affect the
sound. Instead, the Auto Filter offers two kinds of sample and hold: The upper sample
and hold type provides independent random modulation generators for the left and right
channels, while the lower one modulates both channels with the same signal.

3.3.2 Chorus

The Chorus Effect.

The Chorus effect uses two parallel time-modulated delays to create chorus (thickening)
and flanging effects.

Each delay has its own delay time control, calibrated in milliseconds. Delay 1 has a
high pass filter that can remove low frequencies from the delayed signal. Greater high
pass values let only very high frequencies pass through to Delay 1.
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Delay 2 can switch among three different modes. When off, only Delay 1 is audible. In
Fix Mode, only Delay 1’s delay time will be modulated. When Mod is activated, Delay 2
will receive the same modulation as Delay 1.

To set both delay lines to Delay 1’s delay time, turn on the link button (“= ”). This is
especially useful if you want to change both delays with a single gesture.

The Modulation X-Y controller can impart “motion” to the sounds. To change the mod-
ulation rate for the delay times, click and drag along the horizontal axis. To change the
amount of modulation, click and drag along the vertical axis.

You can also make changes by entering parameter values in the Amount and Rate fields
below the X-Y controller. The Amount value is in milliseconds, while the modulation
frequency rate is in Hertz.

Clicking the *20 switch multiplies the modulation frequency by 20 to achieve more
extreme sounds.

The Feedback control determines how much of the output signal feeds back into the
input, while the Polarity switch sets (surprise!) the polarity. Polarity changes have the
most effect with high amounts of feedback and short delay times.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it
to wet only if using the Chorus in a send channel.
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3.3.3 Compressor I

The Compressor I Effect.

A Compressor reduces gain for signals above a user-settable threshold. Compression
reduces the levels of peaks, opening up more headroom and allowing the overall signal
level to be turned up. This gives the signal a higher average level, resulting in a sound
that is subjectively louder and “punchier” than an uncompressed signal.

The two most important parameters are the Threshold and the compression Ratio:

The Threshold slider sets where compression begins. Signals below the threshold are not
processed. Signals above the threshold are attenuated by an amount specified by the
Ratio parameter, which sets the ratio between the input and output signal. For example,
with a compression ratio of 3:1, if a signal above the threshold increases by 3 dB, the
compressor output will increase by only 1 dB. If a signal above the threshold increases
by 6 dB, then the output will increase by only 2 dB.

The red gain-reduction meter shows how much the gain is being reduced at any given
moment. The more reduction, the more audible the effect; a gain reduction above 6 dB
or so might produce the desired loudness, but significantly alters the sound and is easily
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capable of destroying its dynamic structure. This is something that cannot be undone
in later production steps. Keep this in mind especially when using a compressor, limiter
or sound loudness-maximizing tool in the master channel. Less is often more here.

Because compression reduces the volume of loud signals and opens up headroom, you
can use the Out(put) slider so that the peaks once again hit the maximum available
headroom. The Output meter shows the output signal’s level.

A second set of two essential parameters defines how fast a compressor reacts to input-
level changes: Attack time and Release time.

Attack defines how long it takes to reach maximum compression once a signal exceeds
the threshold, while Release sets how long it takes for the compressor to return to
normal operation after the signal falls below the threshold.

A slight amount of attack time (5 - 10 ms) allows peaks to come through unprocessed,
which helps preserve dynamics. If these peaks cause overloads, you can try shortening
the attack time, but extremely short times take the “life” out of the signal, and may lead
to a slight “buzziness” caused by distortion. Short release times can cause “pumping” as
the compressor tries to figure out whether to compress or not; while generally considered
an undesirable effect, some engineers use it on full drum kits to give unusual “sucking”
effects.
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3.3.4 Compressor II

The Compressor II Effect.

Compressor II is a state of the art compression unit– the tool of choice for a wide
range of dynamic processing applications including limiting and loudness maximization.
Compressor II’s design is a lot more sophisticated and capable than Compressor I’s.
It includes frequency-selective compression using a sidechain EQ, variable look-ahead
times and two response modes, Peak and RMS. Compressor I is still a valuable sound
design tool in spite of, or rather because of, its simplicity and roughness, which can
add interesting flavors to your sounds.

A compressor can only react to an input signal once it occurs. Since it also needs to
apply an attack/release envelope, the compression is always a bit too late. A digital
compressor can solve this problem by simply delaying the input signal a little bit.
Compressor II offers three different predelay times: zero ms, one ms and ten ms. The
results may sound pretty different depending on this setting. Keep in mind that using
ten ms of predelay makes the output appear significantly later. You may have to delay
other tracks with a Simple Delay in order to stay in sync.
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Compressor II can either react to short peaks within a signal or to something that is
more related to how people perceive loudness. The parameter for this is the “Peak/RMS”
switch. If you intend to use Compressor II as a limiter in the master section, “Peak”
is probably better since it reacts more to the actual signal level, while “RMS” is usually
more musical. But as always if it comes to compression, trust your ears and not the
meter!

The most exotic feature of Compressor II is the sidechain EQ. The “sidechain” is the part
of the signal that is used to control the compressor. Normally the sidechain signal is
the same as the input signal. However, it can make sense to apply some filtering here.
Imagine a bass drum, a snare and some chords in the background. The bass drum has
a pretty high level and it will normally determine how the compressor reacts. If you
now turn the side chain EQ on and set its Frequency to 100 Hz and the Gain to -15
dB, the bass drum will not influence the compression anymore and the behavior of the
compressor will be very different. You could also set the Frequency to around 1 kHz
and turn up the gain to make the compressor more responsive to the snare. Since the
EQ is only in the sidechain and not part of the normal signal path, it will not change
the sound of the input signal. It only changes how the compressor reacts to different
frequencies of the input.

Unlike Compressor I, Compressor II has a built-in compensation stage that counteracts
the gain loss due to the compression and makes it much easier to adjust the other
parameters.

Careful adjustment of attack and release times is essential when it comes to compression
of rhythmical sources. If you are not used to working with compressors, play a drum
loop and spend some time adjusting Attack, Release, Threshold and Gain. It can be very
exciting!



3.3. THE LIVE EFFECTS 162

3.3.5 EQ Three

The EQ Three Effect.

If you have ever used a good DJ mixer you will know what this is: An EQ that allows
you to adjust the level of low, mid and high frequencies independently.

Each band can be adjusted from -infinite dB to +6 dB using the gain controls. This
means that you can completely remove, for example, the bass drum or bassline of a
track, while leaving the other frequencies untouched.

You can also turn on or off each band using the On/Off buttons located under the gain
controls. These buttons are especially handy if assigned to computer keys...

EQ Three gives you visual confirmation of the presence of a signal in each frequency
band using three green LEDs. Even if a band is turned off, you can see if there is
something going on in it. The internal threshold for the LEDs is set to -24 dB.

The frequency range of each band is defined via two crossover controls: FreqLo and
FreqHi. If FreqLo is set to 500 Hz and FreqHi to 2000 Hz, then the low band goes from
0 hz to 500 Hz, the mid band from 500 Hz to 2000 Hz and the high band from 2000 Hz
up to what ever your soundcard or sample rate supports.
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A very important control is the 24 dB / 48 dB switch. It defines how sharp the filters
are cutting the signal at the crossover frequency. The higher setting results in more
drastic filtering, but needs more CPU.

Note: The filters in this device are optimized to sound more like a good, powerful analog
filter cascade than a clean digital filter. The 48 dB Mode especially does not provide a
perfect linear transfer quality, resulting in a slight coloration of the input signal even if
all controls are set to 0.00 dB. This is typical behavior for this kind of filter, and is part
of EQ Three’s unique sound. If you need a more linear behavior choose 24 dB Mode or
use the EQ Four.

3.3.6 EQ Four

The EQ Four Effect.

The EQ Four effect is an equalizer composed of four parametric filters. Equalizers are
useful for changing a sound’s timbre.

Filter One can switch among three responses: bell-curve (boosts or cuts over a range of
frequencies), low-shelf (boosts or cuts frequencies lower than the specified frequency)
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or low-cut (cuts frequencies below the specified frequency). Filters Two and Three are
always bell-curves. Filter Four can switch among bell-curve, high-shelf (boosts or cuts
frequencies higher than the specified frequency) or high-cut (cuts frequencies above
the specified frequency) modes. Each filter band can be turned on or off independently.
Turn off bands that aren’t in use to save CPU power.

To edit the filter curve, click and drag on one of the filter dots in the XY View. Horizontal
movement changes the filter frequency, while vertical movement adjusts the filter band’s
gain. To adjust the filter Q (also called resonance or bandwidth), hold down the Alt (PC)
/ Option (Mac) modifier while dragging the mouse.

You can also use the numbered filter selector buttons to select a band for editing, then
edit parameter values with the Freq, Gain and Q dials (and/or type values into the
number fields below each dial).

To achieve really drastic filtering effects, assign the same parameters to two or more
filters, or use more than one EQ Four.

As boosting will increase levels and cutting will decrease levels, use the Gain slider to
optimize the output level for maximum level consistent with minimum distortion.
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3.3.7 Erosion

The Erosion Effect.

The Erosion effect degrades the input signal by modulating a short delay with filtered
noise or a sine wave. This adds noisy artifacts or aliasing/downsampling-like distortions
that sound very “digital.”

To change the sine wave frequency or noise band center frequency, click and drag along
the X-axis in the XY field. The Y-axis controls the modulation amount. If you hold
down the Alt (PC) / Option (Mac) modifier key while clicking in the XY field, the Y-axis
controls the noise bandwidth.

The Frequency control determines the color, or quality, of the distortion. If the Mode
control is set to Noise, this works in conjunction with the Width control, which defines
the noise bandwidth. Lower values lead to more selective distortion frequencies, while
higher values affect the entire input signal. Width has no effect in Sine Mode.

Noise and Sine use a single modulation generator. However, Wide Noise has indepen-
dent noise generators for the left and right channels, which creates a subtle stereo
enhancement.
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3.3.8 Filter Delay

The Filter Delay Effect.

The Filter Delay provides three independent delay lines, each preceded by linked low
pass and high pass filters. This allows applying delay to only certain input signal
frequencies, as determined by the filter settings. The feedback from each of the three
delays is also routed back through the filters.

Each of the three delays can be switched on and off independently. The Filter Delay
plug-in assigns delay 1 to the input signal’s left channel, delay 2 to the left and right
channels and delay 3 to the right channel. The Pan controls at the right can override
the delay channels’ outputs; otherwise each delay outputs on the channel from which
it derives its input.

Each delay channel’s filter has an associated On switch, located to the left of each XY
controller. The XY controllers adjust the low and high pass filters simultaneously for
each delay. To edit filter bandwidth, click and drag on the vertical axis; click and drag
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on the horizontal axis to set the filter band’s frequency.

To refer delay time to the master tempo, activate the Sync switch, which allows using
the Delay time beat division chooser. The numbered switches represent time delay in
16th notes. For example, selecting “4” delays the signal by four 16th notes, which
equals one beat (a quarter note) of delay. With Sync Mode active, changing the Delay
Time field percentage value shortens and extends delay times by fractional amounts,
thus producing the “swing” type of timing effect found in drum machines.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit
the delay time, click and drag up or down in the Delay Time field, or click in the field
and type in a value.

Feedback controls how much of the output signal returns to the delay line input. Very
high values can lead to runaway feedback and produce a loud oscillation - watch your
ears and speakers if you decide to check out extreme feedback settings!

Each delay channel has its own volume control, which can be turned up to +12 dB to
compensate for drastic filtering at the input.

The Dry control adjusts the unprocessed signal level. Set it to minimum if using the
Delay in a send channel.
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3.3.9 Gate

The Gate Effect.

The Gate effect passes only signals whose level exceeds a user-specified Threshold. A
gate can eliminate low-level noise that occurs between sounds (e.g., hiss or hum), or
shape a sound by turning up the threshold to where it cuts off reverb or delay tails or
truncates an instrument’s natural decay.

The Threshold slider sets the gate’s sensitivity. If the gate is open and passing signal
(i.e., the signal exceeds the gate threshold), the green LED lights.

The Floor parameter located above the threshold fader can allow attenuating signals
below the threshold rather than just cutting them off. If set to -inf dB, a closed gate
will mute the input signal. A setting of 0.00 dB means that even if the gate is closed,
there is no effect on the signal. Settings in between these two extremes attenuate the
input to a greater or lesser degree when the gate is closed.

The Attack time determines how long it takes for the gate to switch from closed to
open when a signal goes from below to above the threshold. Very short attack times
can produce sharp clicking sounds, while long times soften the sound’s attack.
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When the signal goes from above to below the threshold, the Hold time kicks in. (Note
to tech heads: the gate has hysteresis, so the release occurs about 3 dB lower than the
threshold.) After the hold time expires, the gate closes over a period of time set by the
Release parameter.

3.3.10 Grain Delay

The Grain Delay Effect.

The Grain Delay effect slices the input signal into tiny particles (called “grains”) that are
then individually delayed and can also have different pitches compared to the original
signal source. Randomizing pitch and delay time can create complex masses of sound
and rhythm that seem to bear little relationship to the source. This can be very useful
in creating new sounds and textures, as well as getting rid of unwelcome house guests,
or terrifying small pets (just kidding!).

To refer delay time to the master tempo, activate the Sync switch, which allows using
the Delay Time beat division chooser. The numbered switches represent time delay in
16th notes. For example, selecting “4” delays the signal by four 16th notes, which
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equals one beat (a quarter note) of delay. With Sync Mode active, changing the Delay
Time field percentage value shortens and extends delay times by fractional amounts,
thus producing the “swing” type of timing effect.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit
the delay time, click and drag up or down in the Delay Time field, or click in the field
and type in a value.

You can route each parameter to the XY controller’s horizontal or vertical axis. To assign
a parameter to the X-axis, choose it from the parameter row below the controller. To
assign a parameter to the Y-axis, use the parameter row on the left side.

The Feedback parameter sets how much of the output signal returns to the delay line
input. Very high values can lead to runaway feedback and produce a loud oscillation -
watch your ears and speakers if you decide to check out extreme feedback settings!

You can transpose the grain pitch with the Pitch parameter, which acts much like a
crude pitch shifter.

The Spray control adds random delay time changes. Low values smear the signal across
time, which adds “noisiness” to the sound. High Spray values completely break down
the structure of the source signal, introducing varying degrees of rhythmical chaos. This
is the recommended setting for anarchists.

The Random Pitch control adds random variations to each grain’s pitch. Low values
create a sort of mutant chorusing effect, while high values can make the original source
pitch completely unintelligible. This parameter can interact with the main Pitch control,
thus allowing degrees of stability and instability in a sound’s pitch structure.

The size and duration of each grain is a function of the Frequency parameter. The sound
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of Pitch and Spray depends very much on this parameter.

Grain Delay now also has a dry/wet control; it can be routed to the vertical axis of the
XY controller.

3.3.11 Ping Pong Delay

The Ping Pong Delay Effect.

The Ping Pong Delay effect uses a single tapped delay line to create a delay that jumps
from the left to the right output.

The delay is preceded by a low and high pass filter that can be controlled with an XY
controller. To define the filter bandwidth, click and drag on the vertical axis. To set the
position of the frequency band, click and drag on the horizontal axis.

To refer delay time to the master tempo, activate the Sync switch, which allows using
the Delay Time beat division chooser. The numbered switches represent time delay in
16th notes. For example, selecting “4” delays the signal by four 16th notes, which
equals one beat (a quarter note) of delay. This delay time represents the time it takes
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for the input signal to appear at the left channel. The delay time between the input
and the right channel is twice as long.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit
the delay time, click and drag up or down in the time field, or click in the field and type
in a value.

The Feedback parameter controls how much of the right channel output signal returns to
the delay line input. The feedback loop also includes a filter that can color the feedback
sound, thus producing different timbres with successive echoes.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it
to full wet if using the Ping Pong Delay in a send channel.

3.3.12 Simple Delay

The Simple Delay Effect.

The Simple Delay provides two independent delay lines, one for each channel (left and
right).
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To refer delay time to the master tempo, activate the Sync switch, which allows using
the Delay Time beat division chooser. The numbered switches represent time delay in
16th notes. For example, selecting “4” delays the signal by four 16th notes, which
equals one beat (a quarter note) of delay. If the Sync switch is off, the delay time
reverts to milliseconds. In this case, to edit the delay time, click and drag up or down
in the Delay Time field, or click in the field and type in a value.

The Feedback parameter defines how much of each channel’s output signal feeds back
into the delay lines’ inputs. Internally there are two independent feedback loops, so a
signal on the left channel does not feed back into the right channel and vice versa.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it
to full wet if using the Simple Delay in a send channel.

3.3.13 Vinyl Distortion

The Vinyl Distortion Effect.

The Vinyl Distortion effect emulates some of the typical distortions that occur on vinyl
records during playback. These distortions are caused by the geometric relationships
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between the needle and the recorded groove. The effect also features a crackle generator
for adding noisy artifacts.

The Tracing Model section adds even harmonic distortion to the input signal. Adjust
the amount of distortion with the Drive knob, or click and drag vertically in the Tracing
Model XY window. To adjust the distortion’s frequency or “color,” drag horizontally in
the XY window or double-click on the Freq field and type in a value. Holding the Alt
(PC) / Option (Mac) modifier while dragging vertically in the XY window changes the
frequency band’s Q (bandwidth).

The Pinch Effect section adds odd harmonics to the input signal. These distortions
typically occur 180 degrees out of phase, creating a richer stereo image. The Pinch
Effect has the same controls as the Tracing Model, but generates a rather different
sound.

There are two distortion modes: soft and hard. The soft mode simulates the sound of a
dub plate, while hard mode is more like that of a standard vinyl record.

The stereo/mono switch determines whether the Pinch distortion occurs in stereo or
mono. Set it to stereo for realistic simulation of vinyl distortions.

The Crackle section adds noise to the signal, with noise density set by the Density
control. The Volume control adjusts the amount of gain applied to the noise.
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3.3.14 Redux

The Redux Effect.

Nostalgic for the famed low-resolution sound quality of the Ensoniq Mirage, Fairlight CMI
or Commodore-64 computer? Redux returns us to the Dark Ages of digital by reducing a
signal’s sample rate and bit resolution.

The Downsample section has two parameters: “Downsample” and a downsample Mode
switch.

If the downsample dial is set to “1”, every input sample passes to the output and the
signal does not change. If set to “2”, only every second sample will be processed, so
the result sounds a bit more “digital.” The higher the number, the lower the resulting
sample rate, and the more “deconstructed” the sound. Downsampling is like applying a
mosaic effect to an image: There’s a loss of information and sharp edges occur between
the blocks.
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The Downsample Mode switch defines if the downsampling either interpolates over a
smaller range (“soft,” down to 20.0 samples) or does not interpolate over a larger range
(“hard,” down to 200 samples).

Bit Reduction is similar, but while downsampling superimposes a grid in time, bit re-
duction does the same for amplitude.

If the Bit Reduction amplitude dial is set to 8, amplitude levels are quantized to 256
steps (8 bit resolution). If set to 1, the result is pretty brutal: Each sample contains
either a full positive or full negative signal, with nothing in between.

Bit Reduction defines an input signal of 0dB as 16 bit. Signals above 0dB are clipped,
and the red overload LED will light up.

Turning off Bit Reduction results in modest CPU savings.
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3.3.15 Resonators

The Resonators Effect.

This device consists of five parallel resonators that superimpose a tonal character on
the input source. It can produce sounds resembling anything from plucked strings to
vocoder-like effects. The resonators are tuned in semitones, providing a musical way of
adjusting them. The first resonator defines the root pitch and the four others are tuned
relative to this pitch in musical intervals.

The input signal passes first through a filter, and then into the resonators. There are
four input filter types to select from: low pass, band pass, high pass and notch. The
input filter frequency can be adjusted with the Frequency parameter.

The first resonator is fed with both the left and right input channels, while the second
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and fourth resonators are dedicated to the left channel, and the third and fifth to the
right channel.

The Note parameter defines the root pitch of all the resonators ranging from C1 to C5.
It can also be detuned in cents using the Fine parameter. The Decay parameter lets
you adjust the amount of time it takes for the resonators to be silent after getting an
input signal. The longer the decay time, the more tonal the result will be, similar to the
behavior of an undamped piano string. As with a real string, the decay time depends
on the pitch, so low notes will last longer than higher ones. The Const switch holds the
decay time constant regardless of the actual pitch.

Resonators provides two different resonation modes. Mode A provides a more realistic
sounding resonation, while Mode B offers an effect that is especially interesting when
Resonator I’s Note parameter is set to lower pitches.

The brightness of the resulting sound can be adjusted using the Color control.

All of the resonators have an On/Off switch and a Gain control. A resonator that is
turned off does not need CPU. Turning off the first resonator does not affect the other
ones.

Resonators II through V follow the Note parameter defined in Resonator I, but they can
each be individually transposed +/- 24 semitones using the Pitch controls and detuned
in cents using the Detune controls.

The output section features the obligatory Dry/Wet control and a Width parameter that
affects only the wet signal and blends the left and right outputs of Resonators II-V into
a mono signal if set to zero.
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3.3.16 Reverb

The Reverb Effect.

Input Processing

The input signal passes first through high and low cut filters, whose X-Y controller allows
changing the band’s center frequency (X-axis) and bandwidth (Y-axis). Either filter may
be switched off when not needed to save CPU power.

Predelay controls the delay time, in milliseconds, before the onset of the first early
reflection. This delays the reverberation relative to the input signal. One’s impression
of the size of a real room depends partly on this delay. Typical values for “natural”
sounds range from 1ms to 25ms.
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Early Reflections

These are the earliest echoes that you hear after they bounce off a room’s walls, before
the onset of the diffused reverberation “tail.” Their amplitude and distribution give an
impression of the room’s character.

The Shape control “sculpts” the prominence of the early reflections, as well as their
overlap with the diffused sound. With small values, the reflections decay more gradually
and the diffused sound occurs sooner, leading to a larger overlap between these com-
ponents. With large values, the reflections decay more rapidly and the diffused onset
occurs later. A higher value can sometimes improve the source’s intelligibility, while a
lower value may give a smoother decay.

Spin applies modulation to the early reflections. The 2-D control accesses the depth and
frequency of these modulations. A larger depth tends to provide a less-colored (more
spectrally neutral) late diffusion response. If the modulation frequency is too high,
doppler frequency shifting of the source sound will occur, along with surreal panning
effects. Spin may be turned off, using the associated switch, with modest CPU savings.

Global Settings

The Quality chooser controls the tradeoff between reverb quality and performance. Econ-
omy mode uses minimal CPU resources, while First Class delivers the richest reverbera-
tion.

The Size parameter controls the “room’s” volume. At one extreme, a very large size will
lend a shifting, diffused delay effect to the reverb. The other extreme, a very small
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value, will give it a highly colored, metallic feel.

The Stereo Image control determines the width of the output’s stereo image. At the
highest setting of 120 degrees, each ear receives a reverberant channel that is inde-
pendent of the other (this is also a property of the diffusion in real rooms). The lowest
setting mixes the output signal to mono.

Diffusion Network

The Diffusion network creates the reverberant tail that follows the early reflections. The
decay time control adjusts the time required for this tail to drop to 1/1000th (-60 dB)
of its initial amplitude.

High and low shelving filters provide frequency-dependent reverberation decay. The
high-frequency decay models the absorption of sound energy due to air, walls and other
materials in the room (people, carpeting and so forth). The low shelf provides a thinner
decay. Each filter may be turned off to save CPU consumption.

The Freeze control freezes the diffuse response of the input sound. When on, the
reverberation will sustain almost endlessly. Cut modifies Freeze by preventing the input
signal from adding to the frozen reverberation; when off, the input signal will contribute
to the diffused amplitude. Flat bypasses the high and low shelf filters when freeze is
on. If Flat is off, the frozen reverberation will lose energy in the attenuated frequency
bands, depending on the state of the high and low shelving filters.

The Echo Density and Scale parameters provide additional control over the diffusion’s
density and coarseness, and, when the room size is extremely small, have a large impact
on the coloration contributed by the diffusion.
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The Chorus section adds a little modulation and motion to the diffusion. Like the Spin
section, you can control the modulation frequency and amplitude, or turn it off.

Output

At the reverb output, you can adjust the effect’s overall Dry/Wet mix, and vary the
amplitude of reflections and diffusion with the Reflect Level and Diffuse Level controls.

3.3.17 Utility

The Utility Effect.

Utility can perform some very useful tasks, especially in combination with other effects.
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Most obvious is the Gain control, which allows adjusting the level of the input signal
from -36 to +36 dB. The Gain control is located below the Mute button, which simply
turns the signal off if pressed.

Note: The active/mute controls of a track are always placed at the very end of the signal
chain. However, since you can place Utility anywhere in a signal chain, you can use its
mute function to cut the input of a delay line or reverb without turning off the output
of these devices.

The Left/Right buttons allow further processing of only the left or right channel of a
sample. If, for example, Left is turned on, the right channel is ignored and the left
channel appears on both outputs. This is especially useful if you have a stereo file that
contains different information on both channels and you want to use only one.

The Width control acts as a continuous mono to stereo controller when set from 0 to
100 percent. However, beyond 100 percent the output starts to “fold in” on itself. In
the full right position the output contains only the difference between the left and
right channels. If either the Left or Right button is activated, the Width control has no
function and is therefore bypassed.

At the bottom of the device you will find two Phase (ø) controls, one for each channel.
As the name implies they invert the phase of each channel.

3.4 MIDI Implementation

Live can be controlled remotely from an external MIDI device, such as a MIDI keyboard
or controller box. Do the following to assign elements of Live’s user interface elements
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to MIDI notes or controller messages:

1. Tell Live about the MIDI connection you are using in the MIDI/Sync Preferences
(see MIDI Preferences).

2. Activate MIDI Map Mode by clicking the “MIDI” switch in the Control Bar.

3. Select a user interface element you want to control remotely.

4. Play the MIDI note or MIDI controller that will control the user interface element.

This section describes the details of mapping to the following specific types of Live’s
user interface elements:

A Clip in a Session View Slot.

Session View slots. Note that MIDI and computer key assignments are bound to the
slots, not to the clips they contain.

A Switch.

Switches, among them the track and effect Activator switches, and the Control Bar
switches for the metronome, loop and punch options.

A Radio Button.

Radio buttons. A radio button selects among a number of options. One instance of a
radio button is in the crossfader assignment section (see Using Live’s Crossfader) in each
track, which offers three options: the track is assigned to the crossfader’s A position,
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the track is unaffected by the crossfader or the track is affected by the crossfader’s B
position.

A Continuous Control.

Continuous controls, like the mixer’s volume, pan and sends.

3.4.1 Mapping to MIDI Notes

• Session View Slots Note-on and note-off messages affect clips in the slot according
to their Launch Mode settings (see Launch Modes). Note that slots can be mapped
to key ranges for chromatic playing (see Mapping Clips to MIDI Note Ranges).

• Switches A note-on message toggles the switch state.

• Radio Buttons Note-on messages toggle through the available options.

3.4.2 Mapping to Absolute MIDI Controllers

• Session View Slots Controller values above 63 are treated like note-on messages.
Controller values below 64 are treated like note-off messages.

• Switches Controller values above 63 turn the switch on. Controller values below
64 turn it off.
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• Radio Buttons The controller’s 0...127 value range is mapped onto the range of
available options.

• Continuous Controls The controller’s 0...127 value range is mapped onto the pa-
rameter’s range of values.

Live supports pitch bend and high-precision controller messages with a 0...16383 value
range. The above specifications apply to pitch bend and high-precision controllers as
well, except that the value range’s center is at 8191/8192.

3.4.3 Mapping to Incremental MIDI Controllers

• Session View Slots Value increment messages are treated like note-on messages.
Value decrement messages are treated like note-off messages.

• Switches Increment messages turn the switch on. Decrement messages turn it off.

• Radio Buttons Increment messages make the radio button jump forward to the
next available option. Decrement messages make it jump backwards.

• Continuous Controls There are several conventions used by MIDI hardware manu-
facturers for sending incremental control changes. Each of these conventions uses
a different interpretation of the 0...127 MIDI controller value range to identify
value increments and decrements:

Mode Increment Decrement
Relative (Signed Bit) 65 - 127 1 - 64
Relative (Bin Offset) 65 - 127 64 - 1
Relative (2’s Comp.) 1 - 64 127 - 65
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Live tries to auto-detect the convention used when making an assignment. You
can override the setting using the chooser that appears in the Status Line at the
bottom of the Live screen while mapping a Live control.

3.4.4 Sending Controller Messages

Live can send MIDI controller messages to outboard MIDI devices. This is useful when
working with controller boxes that have endless knobs or motorized faders. These
devices need to be updated when a control’s value changes in Live, because the position
of motorized faders or LED chains has to match the new value.

MIDI controller messages will be sent to the device that is chosen from the MIDI /
Sync Preferences MIDI Control Output Device menu. There is a “Send Control Updates
Now” button that can send the current state of all of Live’s controls after connecting
an external device.
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3.5 Live Keyboard Shortcuts

3.5.1 Managing the Display

Windows Macintosh
Toggle Full Screen Mode F11 F11
Toggle Session / Arrangement View Tab Tab
Toggle Track / Clip View Shift Tab Shift Tab
Toggle Track / Clip / Bus View F12 F12
Hide / Show Track / Clip / Bus View Shift F12 Shift F12
Hide / Show Info View ? ?
Hide / Show Overview Ctrl Alt O Cmnd Alt O
Hide / Show Clips Ctrl Alt P Cmnd Alt P
Hide / Show Input / Output Ctrl Alt I Cmnd Alt I
Hide / Show Sends Ctrl Alt S Ctrl Alt S
Hide / Show Mixer Ctrl Alt M Ctrl Alt M
Hide / Show Crossfader Ctrl Alt F Ctrl Alt F
Zoom In Plus Plus
Zoom Out Minus Minus
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3.5.2 Adjusting Values

Windows Macintosh
Increment / Decrement Up / Down Up / Down
Large Increment / Decrement Page Up / Dn Page Up / Dn
Go Default Del Backspace
Delete Automation Ctrl Del Cmnd Backspace
Type in Value 0..9 0..9
Go to Next Field (Bar.beat.16th) Period, Comma Period, Comma
Abort Value Entry Escape Escape
Confirm Value Entry Return Return

3.5.3 Transport

Windows Macintosh
Play from Start Marker / Stop Space Space
Continue Play Shift Space Shift Space
Play Arrangement View Selection Ctrl Space Alt Space
Record F9 F9
Back to Arrangement F10 F10
Activate / Deactivate Track 1..8 F1..F8 F1..F8
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3.5.4 Editing

Windows Macintosh
Cut Ctrl X Cmnd X
Copy Ctrl C Cmnd C
Paste Ctrl V Cmnd V
Duplicate Ctrl D Cmnd D
Delete Delete Backspace
Insert Ctrl I Cmnd I

By holding down an additional modifier key, some of the above commands can also be
applied to:

Windows Macintosh
Clips and Slots across all Tracks Shift Shift
Time across all Tracks Shift Shift
The Selected Part of the Envelope Alt Alt

Additional Session View commands:

Windows Macintosh
Launch Selected Clip / Slot Return Return
Select Neighbouring Clip / Slot Arrow Keys Arrow Keys
Select all Clips / Slots Ctrl A Cmnd A
Copy Clips Ctrl Drag Alt Drag
Add / Remove Slot Button Ctrl E Cmnd E
Insert Captured Scene Ctrl Shift I Cmnd Shift E

Additional Arrangement View commands:
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Windows Macintosh
Split Clip at Selection Ctrl E Cmnd E
Consolidate Selection into Clip Ctrl J Cmnd J
Loop Selection Ctrl L Cmnd L
Select Time in Loop Ctrl Shift L Cmnd Shift L
Zoom around Selection Plus / Minus Plus / Minus
Auto-Scroll to Follow Ctrl F Cmnd F
Toggle Snap to Quantization / Grid Ctrl G Cmnd G

These commands handle tracks:

Windows Macintosh
Insert Track Ctrl T Cmnd T
Insert Send Track Ctrl Alt T Cmnd Alt T
Rename Selected Track Ctrl E Cmnd E
While Renaming, Go to next Track Tab Tab

Use this command when editing automation or clip envelopes:

Windows Macintosh
Toggle Envelope Draw Mode Ctrl B Cmnd B

Use these commands for editing MIDI/key mappings:

Windows Macintosh
Toggle MIDI Map Mode Ctrl M Cmnd M
Toggle Key Map Mode Ctrl K Cmnd K
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3.5.5 Clip View Sample Display

Windows Macintosh
Move Selected Warp Marker Left / Right Left / Right
Select Warp Marker Ctrl Left / Right Cmnd Left / Right
Move Loop by Loop Length Up / Down Up / Down
Zoom around Loop / Region Plus / Minus Plus / Minus

3.6 Live’s Copy Protection

Live is protected against illegal use by a copy protection scheme. This scheme has
been designed to meet the highest security standards while avoiding hassles for the
customer. If you find this procedure to be an inconvenience, please understand that the
copy protection secures your investment: It allows ableton to provide you with support
and continue developing Live.

As you start up Live, you will be presented with a dialog that walks you through the
procedure in two steps.

3.6.1 Step 1: Entering Your Serial Number

As an owner of Live, you have received a Serial Number from ableton, either via e-mail
(if you ordered Live directly from ableton), or as part of the Live package. In the latter
case you will find your Serial Number on a sticker on the program CD tray.
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The Fields for Entering Your
Serial Number.

The Welcome dialog contains six fields for typing in the Serial Number. Each field holds
four characters. The Serial Number is composed of numbers 0..9 and letters A..F. If
you accidentally type the wrong string into a field, the field turns red. When you have
successfully entered the Serial Number, click the “Unlock” button to proceed.

The Serial Number identifies your ownership of Live. Because your Serial Number is a
valuable good, you should keep it in a safe place and out of reach of unauthorized hands.
Please be aware that sharing your Serial Number will render it unusable. The only way
for ableton technical support to help you get back your Serial Number if you lose it is via
your registration data. Therefore, please register your product, as otherwise you might
lose your property!

3.6.2 Step 2: Unlocking Live

The second step of authorizing Live is called “Unlocking.” Unlocking means associating
your Serial Number with a specific computer. Please be aware that the standard Live
license grants you the right to use Live on only one computer at a time. You can,
however, unlock Live with your Serial Number more than once under the legal and
technical conditions described below (see Copy Protection FAQs).

http://www.ableton.com/index.php?main=register
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The Unlock Key

For unlocking, you require an Unlock Key that can only be created by the ableton server.
Unlocking therefore requires access to the internet. The computer from which you
connect to the internet does not have to be the same computer for which you wish to
unlock Live, but it does make things easier.

The Challenge Code

The ableton server creates the Unlock Key from your Serial Number and a so-called
Challenge Code. The Challenge Code is a “fingerprint” that Live takes of your computer’s
components. For details, please see the corresponding section (see Copy Protection
FAQs).

Unlocking Online

Unlocking Live Online.

If the computer you want to unlock Live for is connected to the internet, the only thing
you need to do is press the “Unlock Online” button. Live will then make a connection
to the ableton server, send your Serial Number and Challenge Code to the server, and
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receive the Unlock Key from the server. No information other than this is exchanged
between your computer and the ableton server.

Unlocking Offline

Unlocking Live Offline.

If the computer you want to unlock Live for is not connected to the internet, you can
use any other computer to access the ableton server’s web interface. This is a web site
with fields for entering your Serial Number and the Challenge Code, which you can copy
from Live’s Unlock dialog.

http://www.ableton.com/index.php?main=unlock
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The Live Unlocking Web Site.

If you have entered your Serial Number and Challenge Code correctly, another web
site will appear to provide you with the Unlock Key. There now are two options for
transferring the Unlock Key to the computer that is to be unlocked:

Follow the web link to download the Unlock Key as a file. Transfer the file to the target
computer via a diskette or CD-ROM. Then, press the Unlock dialog’s “Load Unlock Key”
button to load the Unlock Key file.

The Unlock Key Can Be
Downloaded as a Text File.

OR it might be more convenient to print the web site with the Unlock Key on it. On the
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target computer, press the “Enter Unlock Key” button to open a dialog with fields for
typing in the Unlock Key. Typing it in is easier than it first appears because the fields
turn red if you type the wrong string.

Manually Enter Your Unlock
Key.
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3.6.3 Copy Protection FAQs

Can I run Live without a Serial Number?

Live Can Run in Demo Mode.

If you do not (yet) own Live, you can work with Live in Demo Mode. Demo Mode offers
Live’s complete functionality, but saving, rendering to disc and resampling are disabled.
To run Live in Demo Mode, please click the relevant button.

Click Here if You Are
Interested in Buying Live.

If running Live in Demo Mode raises your interest in purchasing the full version of
Live, please click the “Buy Live” button or visit the ableton web shop. This site con-
tains information about ableton’s distributor and dealer network. It also offers you the
opportunity to buy Live online.

http://www.ableton.com/index.php?main=shop
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What if I Change My Computer’s Components?

If the Challenge Code of your computer changes for some reason, Live will indeed ask
you to unlock the software another time (see Can I Unlock Live more than once?).
The Challenge Code does not change, however, when computer peripherals are replaced
(audio or MIDI hardware, printers, modems). The Challenge Code may change if the
motherboard, processor or network card is replaced. On some computers, reformatting
a hard drive also changes the Challenge Code.

Can I Unlock Live more than once?

The standard Live license allows you to use Live on only one computer at a time. If you
have registered your product, the ableton server will, however, provide you with two
Unlock Keys in good faith that you will use Live on only one machine at a time. Just
proceed as described in the corresponding section (see Step 2: Unlocking Live).

You can, therefore, run Live on both a studio desktop computer and a tour laptop,
but not at the same time. If you are using a Macintosh and switching back and forth
between OS 9 and OS X, you can unlock Live on both systems.

Should the ableton server reject your demand for another Unlock Key, please contact
ableton’s technical support. They can be reached by:

• E-mail;

• telephone: +49 (0)30 - 288 763 151 (available Monday to Friday 11 to 15hrs CET);

• fax: +49 (0)30 - 288 763 11.

http://www.ableton.com/index.php?main=register
mailto:support@ableton.com
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To speed up the process, please:

• register your copy of Live;

• include a brief explanation of the circumstances.

To use Live on more than one computer at a time, you require a Secondary License or
a Site License. ableton offers these licenses at special rates. Please contact the sales
team for details.

Can I play my Set from a Computer that is not Unlocked?

In Demo Mode, you can load and perform a Live Set with no time limitation. You cannot,
however, save changes to the Live Set, resample, or render to disc. When you go on
tour, consider taking along your Live program CD and a CD with the last state of your
Live Set(s). In case of an emergency, you can install and run Live on any computer
available and play your backup Live Set(s).

What do I do about Problems or Questions Regarding Copy Protection?

Please contact technical support. They are happy to help!

http://www.ableton.com/index.php?main=register
mailto:sales@ableton.com
mailto:sales@ableton.com
mailto:support@ableton.com
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and automation editing. . . . . . . . . . . . . . . . . . .35
and recorded audio . . . . . . . . . . . . . . . . . . . . . . . 69

Unfold Track button. . . . . . . . . . . . . . . . . . . . . . .24, 39
Unlock Key . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194
Unlocking Live . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193

more than once . . . . . . . . . . . . . . . . . . . . . . . . . 199
offline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195
online . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194
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